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Preface

Welcome and thank you for your decision to use CLEAN or CLEAN PLUS.
Using CLEAN/CLEAN PLUS, your PC and your CD recorder, you can
create your personal Audio CD or MP3-CD (Data CD) from other CD, vinyl
or cassette recordings. CLEAN gives you the easy-to-use optimized high-
quality tools that let you compile and even professionally restore the audio in
the process.

The software of both products is identical. The only difference between
CLEAN and CLEAN PLUS is, that the latter comes with a Phono PreAmp.

We assume that you have previously not been working as a restoration engi-
neer or CD producer and we would therefore like to introduce you to some of
the topics that pop up when the issues “Making music on your PC" and
“Record player handling” are involved. Many years after the successful intro-
duction of the CD many people will still know what a record is and how to
handle it, but the specifics and the necessary technical devices for the best
playback conditions might not be that clearly present in memory any more.

The path from the record player into your PC

You will surely have recorded music on your PC before. You own a sound
card with good AD/DA converters and nothing was more simple than plug-
ging the output of your CD player or CD-ROM drive into the input of your
sound card and record music as a WAV file. The level could easily be ad-
justed and the sound of the WAV file met your expectations.

If — on the other hand — you wish to record music from a vinyl record this way,
you definitely need a pre-amplifier. That is why CLEAN PLUS includes one.

Directly connecting your record player to your sound card would not give you
a usable signal. Even if you could feed your sound card with a high level sig-
nal, the treble would be distorted and the signal would sound incomplete. The
reason for this is that the record player only transfers a very low useful signal.

Another aspect is, that a record does not provide a well balanced frequency
spectrum. Instead, it gives you a lot of treble and not much bass. This is the
result of the technology used: a good sounding bass would produce strong
record groove deflections that in turn would cause the stylus to jump to the
next groove upon each bass drum hit.

For this reason the CLEAN Phono PreAmp has a special phono input, same
as Hi-fi amplifiers. Besides providing the pre-amplification, this input is
equipped with a special equalizer, optimized for record playback. The equal-
izer makes up for the effect of the “bent” frequency characteristics of the
record by separately amplifying the treble and bass signal components.
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If you have the program version that includes the Phono PreAmp, then you
merely need to fetch your records from the cellar, connect record player and
Phono PreAmp, install CLEAN and start to record.

If you have the product version without the Phono PreAmp and wish to record from
vinyl records, then you will have to dust off your old Hi-fi amplifier and connect the
record player to its Phono socket and the sound card to its Tape or Aux out.

If your Hi-fi amplifier is defect, then you need a dedicated pre-amp to bring the record
player signal onto a frequency corrected Line level.

Now you can transfer the music on your records into your computer with a sufficient
level.

Vinyl needs care

CLEAN has restoration functions to remove rumble noise, clicks, crackles
background noise and sibilants etc. from your music recordings. The algo-
rithms used for these functions are equal in every aspect to high-quality stu-
dio devices. This technology will however only give you maximum results, if
the source delivers the best possible signal-to-noise ratio. This means that
you should carefully clean your records before you transfer the music into
your computer. This will make sure that the groove does not contain dust
that would otherwise lead to crackles.

If you use a cleaning fluid, you should definitely rinse your records with wa-
ter (preferably the decalcified variant) as cleaning fluids have the effect to
glue small dust particles into the record groove.

Mineral water containing less mineral and sodium will also give you excel-
lent results when you rinse your records after cleaning them.

The sound is distorted

Years of listening to CDs have trained our hearing to react sensitively to dis-
tortions. Some of the distortions that occur when you play back records are
inherent in the medium itself.

The pick-up arm does not always have a strictly tangential position to the
record groove. In addition, groove spacing decreases towards the center of
the record. The physical circumstances can not be changed, but it is imper-
ative that you make sure that the stylus is in a good state. If it is worn, you
should get a new one.

If you have correctly connected the Phono PreAmp and the records rotate

under a new stylus, you can now start to adjust the recording level of your

sound card. Currently available sound cards generally offer a dynamic range
and a signal-to-noise ratio of at least 80 dB.
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As a record can only provide ca. 60 dB, your sound card will most probably
be sufficient to produce good recordings on your PC. You should still only
use ca. 85% of the theoretically possible recording level. This way, you do
not run the risk to produce ugly sounding digital distortions caused by a too
high level; or undesired noise, if you record more than 60 dB. These un-
wanted effects only make the work of the restoration algorithms harder and
increase the deep-frequency rumble noise of the record player.

The hunt for the optimum level

One obstacle for many audio recordings on the computer is finding the right
level adjustments. Sound cards do not always offer a reliable level display. In
order to make the best possible setting for your system, you should use the
same methods that are used in a professional recording studio:

Use test signals with an exactly defined level of O dB to adjust the wave
channel and master levels of your sound card as well as that of other possi-
bly used devices like DAT, MD or cassette recorders.

In the Calibrate directory on the CLEAN CD you can find the files 1kHz
Tone.wav, 10 kHz Tone.wav, 80 Hz Tone.wav and 100 Hz Tone.wav. These
sound files contain pure sinusoidal signals with an exact level of O dB.

[0 Attention: The Test tones are very loud! Make sure that volume is reduced
to a minimum on your monitoring system before you load and play back
any of these tones. Do so to take care of your speakers, your ears and the
good relations to your neighbours.

You can use the cycle playback feature in CLEAN for continuous playback,
then you don't have to start playback again and again.

While playing back one of the test tones, you can adjust the level of your
complete system. First, you should use the Output faders in CLEAN to set
the output volume in a way that your sound card does not overload.

[0 The Windows MME driver only lets you control the output volume, if your
sound card has a software mixer panel.

You can also record the test tone with your DAT, MD or cassette recorder,

if your sound card is connected to a stereophonic sound system. Use the in-
put controls of these devices to set them to a maximum input of 0 dB. You

should not change these settings later.

Have fun applying CLEAN to your favourite music.
The Steinberg Team
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Using CLEAN

This section gives you a general overview on how to use CLEAN in practise.
It also contains cross-references to the sections that hold the information
about the respective issue.

The basic concept behind CLEAN is that you work on a CD Project. In or-
der to use CLEAN you must therefore first create a new Project or load one
that you have saved previously. A Project is a file that contains the complete
data set of the CD you are about to create.

¢ Start by double clicking the CLEAN icon on the desktop or in the Start
menu.
You can also start CLEAN by dragging a Project file onto the icon.

¢ Select “Create New Project” or “Open existing Project” in the dialog that
appears.
Find more information on file handling on page 81.

¢ Now you can either choose to use the IntelliAssistant to guide you through
all preparations and automatically carry out the necessary steps, or pro-
ceed as described below.
Please find a description of how the IntelliAssistant works on page 9.

¢ Import the desired Tracks as WAV or MP3 (will be converted into WAV for-
mat) files from CD or record them (e.g. from record or tape).
Find more information about these issues on page 12 (Importing Tracks from hard
disk), page 13 (Importing Tracks from Audio CD), page 18 (Recording audio in
CLEAN) and on page 87 (Recording audio in Wavelab Lite).

¢ By selecting an entry from a Category (“Cat.”) pop-up menu, you can inform
CLEAN about the source medium of each Track (cassette, record or CD).
This helps CLEAN to select the best possible restoration settings when you use the
AutoClean function. See page 28.

¢ During recording or later, you can let CLEAN automatically check the au-
dio for silence and have it insert Markers. Markers can also be inserted
manually. You can move and remove them.
Based on the Marker positions you can cut your Recordings into individual
tracks and put them onto the Track list.
Please look up “The Record Dialog” on page 18 and “The AutoMarker functions” on
page 44.

* You can now play back, name and sort the Tracks and determine the gap
time (the length of the pause between any two Tracks).
Read about this on page 17 (playback), page 15 (naming and gap time) and on
page 15 (sorting).
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You can shorten Track lengths and define a fade-in and/or fade-out for
each Track.

See “Setting the Track length — The Start and End Markers” on page 42. and “The
Fade-in and Fade-out Markers" on page 43.

You can use a humber of very powerful pro-quality tools for restoration,
enhancement and mastering as well as internal and external effects to
process the sound of each Track.

Processing can be done in real time, so that you can monitor the effect, or by calcu-
lating and creating a file. Find more information starting on page 26.

Using the AutoClean function, you can let CLEAN analyse audio for clicks,
crackling and noise. You can preselect one of three restoration modes of
different strengths. CLEAN analyses the audio and automatically adjusts
the respective restoration effects accordingly. The five most important res-
toration effects provide Audition buttons which let you separately monitor
the signal parts removed by each effect.

Please read more on page 28.

Using the audio editor Wavelab Lite, that’s part of the CLEAN package,
you can define a specific noise finger print. This can then be used in
CLEAN to remove this specific noise using the Finger Print DeNoiser.
Read more on page 29.

You want to improve the sound of a recording with a bland sound? You can
let CLEAN analyse a better sounding reference Track that you play back
via your sound card (e.g. from your computer’s CD drive) or that resides as
a Wave file somewhere on your hard disk. Then you can apply the results of
the analysis to the bland sounding files. Listen and wonder how!

Read more on page 32.

You want to bring your favourite music into the MP3 format? No problem
with CLEAN. No matter if you record from CD, record or cassette, if you
process your own music or imported MP3 files: CLEAN can turn it all into
an MP3 file and it supports a whole range of different quality levels.

Find more information in the section “Exporting audio in MP3 format” on page 79.

CLEAN lets you define the positioning of your speakers on-screen and
add Surround sound quality to your CD tracks.
Read more on page 38.

Finally, you can use CLEAN to record the CD-R.
Find details on how to do this in the section “Exporting audio in MP3 format" on
page 79.
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The IntelliAssistant

HSITON3

This intelligent Assistant actively helps you make appropriate settings and
automatically carries out all processing and recording onto CD. This lets you
quickly and easily achieve good results.

Proceed as follows:

1. Click on the IntelliAssistant button to bring up the IntelliAssistant dialog.

Click on this button... ——®»

to bring up this dialog \

IntelliAssistant
Use this Fader
111
to move the
Welcome to the Clean IntelliAssistant! visible part of
the dialog up
or down

The Clean Intelidssistant is a step by step guide that
helps you to perfectly restore and optimize the
sound of your music, before you record it onta CD.

Click here to Click the right OK button —
close the dialog ~ button to go to next This lets you
step and the left confirm your

button to go to the  settings
previous step

2. Follow the instructions and make the desired settings.
CLEAN surrounds the program element, that you must use to make your next set-
ting, with a red flashing frame.

3. Confirm all actions by clicking the OK button. Then go to the next step.
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The CLEAN window

The CLEAN window is subdivided into a number of different areas.
They represent the major functional groups within the program.

The most important of these are called Track list, the Restoration, Enhance-
ment, Mastering and Surround sections as well as the Waveform display.
They are described in the following sections of this manual.

The Restoration, Enhancement,
Track list Mastering & Surround sections

£3 Clean - D:ACleandProjects\My first Compilation.cpf
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Output volume controls Waveform display

The CLEAN window

CLEAN has a number of additional controls and displays. Among these are
the Volume and Equalizer controls, the AutoClean function, the Processing
buttons as well as various displays.

Many CLEAN window elements are equipped with local Tool Tips, short ex-
plaining bits of text that pop up when you move the mouse cursor on the el-
ement and wait for a short while.
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The Track list

Author name Track time

CD Track number l Track title Pause length Source medium category
Al

'Y v vvy

Nr.  Author Title Pause Time Cat.

01 recorded | Coconut Radic 2 0313 e - Faderto

02 |recorded |lzland inthe sun| 2 |02:44 ‘move the
List ontrics 03 |recorded | Sky 2 |0323 of";i"’:'l‘?sf’i”

04 |recorded |Bad News 2 4w p

D5 |impoted |One step ahead| 2 |0354 or down

OF limported |Elizabeth’seyes| 2 0439

07 limported | Take my place 2 0402

02 |imported  |'Wounded Knee 2 0355

03 limported | Cowboysélnd... 2 0345

Left:

Burn Audio CD
right:

Burn Data CD

|_>

Left to right:
Load audio file,
Remove Track,
Remove Track
Delete Track Transport controls, left to right: Stop, Previous Track,
and Cycle Rewind, Play, Fast Forward, Next Track, Record

The Track list is located in the upper left corner of the CLEAN window. You
can use it to import, name, record and play back audio Tracks as well as
change the order in which the Tracks are recorded onto CD-R.

This is also where Tracks are removed from a Project or even completely de-
leted from your hard disk. At the bottom of the Track list you can find a
number of recording and playback functions.

All entries in the Track list — except for Time can directly be changed in the
list.

The various functions are described on the following pages.
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Importing Tracks from hard disk

CLEAN can import audio files in the WAV and MPEG1-Layer3 (generally
called “MP3") formats.

CLEAN can read files with a resolution of 16 bits and sample rates between
22.050 kHz and 96 kHz. It automatically converts them into the CD stand-
ard format (16 bits, 44.1 kHz).

MP3 files are automatically converted into WAV format. These files can then
be processed in CLEAN as any other WAV files and be recorded onto CD-R.

[J You can also export files in MP3 format! Find more information in the sec-
tion “Exporting audio in MP3 format” on page 79.

Proceed as follows to import a piece of audio, that is available as a mono or
stereo WAV or MP3 file, into the Track list:

1. Click on the “Import” button or select “Import WAV/MP3 file”
from the Import menu. @
A file selector opens.

2. Select the desired WAV or MP3 file, then click “Open”.
The file is imported and displayed in the Track list.

CLEAN transforms monophonic 16 Bit/44.1 kHz format files into a stereo-
phonic files of the same format and checks whether enough space is availa-
ble on your hard disk to save the file.

If you import MP3 files, they will automatically be converted. During conver-
sion, the Process Time indicator informs you about the current state of the
conversion.

You can also import several WAV or MP3 files in one go:

¢ Hold down the [Ctrl] key on your computer keyboard while selecting the
files with the mouse.
To import several files that are adjacent to each other in the file selector, hold down
[Shift] on your computer keyboard and click on the first and the last file of the desired
block.

[l Importing Tracks in CLEAN is not limited to the total playing time of an
Audio CD (up to 80 minutes). You rather can exceed this time limit, e.g. to
save your restored audio data onto a DAT cassette (longer playing time) in-
stead of on CD.

CLEAN / CLEAN PLUS
ENGLISH - 12



Drag and Drop

You can also use Drag and Drop to drag WAV and MP3 files from the
Desktop, “My Computer” window or Windows Explorer into the Track list:

¢ Find the desired file, click on it and drag it into the Track list while you con-
tinue to hold down the mouse button.
MP3 files will automatically be converted.

[0 Project files can also be opened by using Drag and Drop, see page 81.

Importing Tracks from Audio CD

You can use CLEAN to directly import audio from any Audio CD. The data
is saved as a WAV file, i.e. a digital copy of the imported Track is saved onto
your hard disk. There is no D/A conversion, thus no loss in quality. This
method of directly reading the audio data from CD is often called grabbing.
Proceed as follows:

1. Open the Import menu and select “Import Tracks from CD..."”.
A dialog opens.

Import audio tracks from CD

|sCSI1D 0: LTE-ON LTR-161018 =
Title | Length [ =
Title 1 00:04:38
Title 2 00:03:15
Title 3 00:02:51
Title 4 00:02:56
Title 5 00:02:31
Title & 00:04:00
Title 7 00:03:56
Title 8 00:03:04
Titl= 3 00:02:52
Titl= 10 00:02:51
Title 11 00:03:00
Titl= 12 00:03:08 -
Titl= 13 00:03:14
Titl= 14 00:02:50
Titl= 15 00:02:39
Tite 1R - 12-773 =
V' Add to Project
|
| Imnport |
ID:\EIean4Proiects\To be Frank. wav | Cancel |

The “Import audio tracks from CD" dialog
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2. Select the CD-ROM drive from which you wish to import the audio Tracks in
the pop-up menu on the top left of the dialog.
If you only have one CD-ROM drive installed in your computer system, you can of
course only select that here.

3. Insert an Audio CD in the selected drive.
The Tracks on the CD appear in a list in the middle of the dialog.

4. Select one or several Tracks for import onto your hard disk by clicking on
them.
Selecting works similar as in the Windows Explorer:
Hold down the [Ctrl] key on your computer keyboard, if you wish to select several
Tracks that are not adjacent in the list.
To select several adjacent Tracks in the list, hold down [Shift] on your computer key-
board and click on the first and the last Track of the desired block.

[0 You can directly add more Tracks to an open Project. Use the “Add to
project” function in the “Import Tracks from CD...” dialog for this purpose.
The files that you import with this method are stored in the same directory
as the previously imported files for this Project.

5. Input a file name and a path for the imported WAV file(s). If you add files to
an already open Project, this will not be necessary.
To do this, click on the small grey button with the three dots, next to the “Cancel”
button in the dialog. When you first open the dialog, its standard path setting is
C:\track.wav).

6. Start importing by clicking on the “Import” button.
Imported files are directly added to the Track list.

7. Close the dialog by clicking “Cancel”.

CLEAN / CLEAN PLUS
ENGLISH - 14



Changing the entries in the Track List
To edit the entries Author, Title and Pause in the Track list:

* Double click the entry that you wish to edit, enter the desired changes by
typing on your computer keyboard and confirm by pressing [Return].
Preset Pause time — the length of the pause between two Tracks on the CD - is 2
seconds. You can change this to a value between 0 and 4 seconds. Higher values
will automatically be corrected to 4 seconds.

To edit the Category entry:

¢ Right-click into the “Cat.” column to bring up a pop-up menu and select
one of the three symbols (CD, vinyl record, cassette) or “Nothing” to inform
the program about the source medium of the respective Track.
This helps CLEAN to select the best possible restoration settings when you use the
AutoClean function or use the IntelliAssistant.

CD Text Information

All entries in the Author and Title columns are recorded onto CD as CD
Text, which is supported by some players which show this information dur-
ing playback.

Changing the Track order in the list

CLEAN playback must be stopped when you change the Track order. Do
this:

¢ Simply drag the desired Track to its new position. To do this, click on the
Track that you wish to move, hold down the mouse button and move the
mouse pointer to the slot where the Track should wind up.
A white line indicates the upper rim of the moved Track.

[1 Track time can be changed by using the Markers in the Waveform display.
This is described in the section “Setting the Track length - The Start and
End Markers” on page 42.

Moving the visible part of the Track list

If the Track list contains more than 14 Tracks, you can use the fader to the
right of the list to move the visible part.
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Removing a Track from the Track list

When Playback is stopped, you can remove a Track from the Track
e list, without deleting its WAV file from your hard disk.

¢ Select the file in the list and click the “Remove” button below the Track list
or press the [Delete] key on your computer keyboard.
Deleting a Track

You can also remove a Track from the Track list and delete its WAV
e file from your hard disk.

¢ Select the file in the list, then click the “Delete” button below the Track list.

[l Deleting is an irreversible action! If you delete a file, it is lost and can not
be recovered!

CLEAN / CLEAN PLUS
ENGLISH - 16



Recording and Playback functions

[1 To use the Recording and Playback functions, you must first create a
Project or load one from disk.

Except for the Record button, these buttons essentially work in the same
way as those on your cassette recorder or CD player. Here's what each but-

ton does:
This button is called: If you click on it...
Stop ...playback stops.
Play ...playback starts.
Rewind ...you move the current playback position

backwards in time.

Previous Track ...you select the previous Track in the Track
list.

Fast Forward ...you move the current playback position
forward in time.

Next Track ...you select the next Track in the Track list.

Record ...the Record dialog will be opened where you
can make several recording settings, and
start and stop recording. The details are
described below.

Cycle ...and the button is displayed in blue,

playback playback of the current Track is repeated
indefinitely. Attention: this button actually is
an On-/Off switch! If the button is switched
off (shown in grey), the complete Track list
will be repeated.

"UEEERNE

Except for the Record and Cycle buttons, all buttons always affect
the Track that is selected in the Track list!
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The Record Dialog

The Record dialog opens when you click on the Record button. Recording
any analog signal from record, audio cassette etc. is done in this dialog.

Record Dialog

Input Level
L

Atten
R L

High [-20 dB] -
T
=

Record Path
D:ACleandProjects\Recordings: - -

Recording length and size
0:00:00 (0.00 MEvyte)

2 Seconds I

Here you find buttons to start or stop the actual recording and a Pause but-
ton to set CLEAN into “record ready” mode. You can also control whether
recording should start or stop automatically as soon as the input signal
reaches or falls below a certain level. You can let the program automatically
insert a Marker if the level falls below a certain minimum level.

The individual functions:

Input level meters These two “LED" meters display the level of the signal that arrives
at CLEAN's input. It is a good idea to set the input level so that
level peaks reach the yellow “LED” area but never the red
segment at the top. If the signal is too low, you will record noise,
if it is too high, it will clip drastically and not sound good.

CLEAN / CLEAN PLUS
ENGLISH - 18



Input level faders

Record Path
Recording length
and size
AutoMarker/-Stop

(Threshold)

Delay AutoMarker

AutoStart (Thresh-
old)

Record Duration
(h:mm)

Delay AutoStop

Record

Stop

These Faders can be used to attenuate the signal that arrives at
CLEAN's input. The signal might have already been set at the
source outside the computer or by the Mixer-software of your
sound card. Find additional information in the next two sections
(“The Sound card dialog” and “Setting Record and Playback
volume”).

Here you can define the path under which your recordings are
stored on your hard disk. If you click on the button with the three
dots, you can define the path using a file selector.

As soon as recording starts, the length of the recording in hours,
minutes and seconds is displayed here. The value in brackets
shows the actual size of the recorded file.

If the AutoMarker or AutoStop function (see below) is checked —
means active — and the level of the recorded song falls below the
value set here, CLEAN will automatically stop recording or insert
a Marker into the waveform.

This function is active if the check mark is visible to the left of the
pop-up menu. If this function is active, you can select a delay time
in the pop-up. When the signal falls below the Threshold defined
under AutoMarker/-Stop (Threshold), the program waits for the
time-span defined here before it inserts a Marker. This may be
useful if the song ends with a long decay. Markers are used to let
CLEAN automatically cut a longer recording into separate
Tracks.

This function is active if the check mark is visible to the left of the
pop-up menu. If this function is active, CLEAN will automatically
start recording, as soon as the source signal has a higher level
than the one set here.

This function is active if the check mark is visible to the left of the
field. Instead of using the AutoStop function (see below) to stop
recording, you can insert a time value in this field after which
recording is stopped automatically. You can set a recording
length in hours and minutes. The maximum value is 2 hours. This
function is not available, if you have activated Delay AutoStop.

This function is active if the check mark is visible to the left of the
pop-up menu. Activate this function and select a time value.
When the signal falls below the Threshold defined under
AutoMarker/-Stop (Threshold), the program waits for the time-
span defined here before it stops recording. This may be useful if
the song ends with a long fade-out. This function is not available,
if you have defined a Record Duration.

Clicking on this switch will immediately start recording.

Click on this button to stop recording.
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Pause By clicking on the Pause button, you set CLEAN into “record
ready” mode. The button flashes to indicate this. If you have
activated the AutoStart or AutoStop functions mentioned above,
recording will automatically be started or stopped.

Close Click on this button to close the dialog.

Discard If you click on this button, the last recording that you have made
since you have opened the dialog this time will be deleted from
disk.

Soundcard Click on this button to open the Soundcard dialog which is

described next.

[0 As an alternative, you can also use WaveLab Lite (comes on the CLEAN
CD) for recording audio, as this extremely fast Audio Editor offers addi-
tional functions. Find more details on page 87.

What can | do if recording does not work immediately?

CLEAN uses the hardware (and its active ports) selected in Windows' Mul-
timedia Properties control panel.

If you e.g. wish to use a Soundblaster AWE 64 sound card for recording,
this card must previously (in most cases during card installation) have been
selected as “Preferred device” in the Multimedia Properties control panel.

1. To check this, open the My Computer window on your Windows desktop.

2. Open the Control Panels folder and double-click the Multimedia icon.
The Multimedia Properties dialog opens.
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Select the “Audio” tab (which is normally immediately visible) and check
what’s selected in the “Preferred device” pop-up menu. If you have more

than one audio card installed in your system, then select the desired device
in this pop-up.

If you wish to find out whether the Line input of the Soundblaster card in
our example is active, you will have to open its audio mixer panel.

Please find more information about the sound card that you use in its hard-
ware and software documentation.
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The Soundcard dialog

S Soundcard
Playback Recording
[ s724/36 Dt (142)1) i [sT24/38In (142)1) j

Buffers {4...10): I 4 Buffers {4...10): I 4
: I F27ES Buffer size (bytes): I 32768

ize {bytes):

This dialog is used to select the sound card inputs and outputs that you use
with CLEAN and to which you have connected an external analog sound
source like e.g. the combination of record player and Phono PreAmp and
your monitoring equipment.

The sound card is used for analog/digital conversion.

¢ Open the pop-up menus to select the desired inputs and outputs.

Depending on the sound card you use, you may be able to set the number
of buffers and their size below the two pop-up menus. The resulting latency
time (delay caused by the time needed for signal processing) will be dis-
played.

If you click “OK?", you confirm your settings and close the dialog.

If you click “Cancel”, you cancel your settings and leave the dialog with
grace.
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Setting Record and Playback volume

Record volume

When you use CLEAN to record audio onto your hard disk, this is what hap-
pens:

*  The audio signal from an external source (like e.g. the Phono PreAmp) arrives at the
input of your sound card where it is converted from an analog to a digital signal.

*  The input to the analog/digital (A/D) converter of the sound card is either controlled
by a Mixer software, that came with your sound card or by the Mixer in the Windows
Multimedia control panel.

*  No matter which one you use, it is in one of these Mixers where you can cause or
prevent a distorted signal. It is therefore very important that you play back the signal
to be recorded and use the level indicators of the Mixer or your ears to get a suffi-
cient, but undistorted signal into the computer.

*  After the A/D converter stage, the signal finally arrives at CLEAN's internal input
and you can use the CLEAN “Input” faders and level indicators to control the actual
recording level. The only thing that you have to keep in mind is that the “Input” faders
in CLEAN can only attenuate the signal as it has already passed the input of the
sound card. If the signal has already been distorted at the sound card input, pulling
down CLEAN's “Input” fader will only attenuate a distorted signal.

Input Level Attenuation
L R L R

Input level faders and display in CLEAN's Record dialog.

Before you use CLEAN for recording from vinyl or cassette, you should
check the Recording Control settings of your audio card. The sound source
and recording level settings are very important for a successful recording.
Proceed as follows:

1. Open the Mixer application of your audio card: On the Start menu on the
Programs submenu, select Accessories. From the submenu that appears,
select Entertainment, then Volume Control.

The Volume Control dialog opens.
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2,

On the Options menu in this dialog, select “Properties”.
The Properties dialog opens.
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3. In the “Adjust volume for” section of the dialog, activate the Recording op-

tion and click “OK*.
The Recording Control dialog opens.
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Specify the audio source by activating the Select checkbox in the Line In
section of the dialog.

Use the fader in this section to accurately predefine the recording level. You can later
fine tune this setting from within the program.

Connect the desired sound source (a cassette recorder or a record player
with PreAmp or PreAmp/Equalizer) with the corresponding socket of your
audio card (usually marked in red) and activate playback of the source sig-
nal.

Now you can start with the actual recording.

Use the Input fader and level meter in CLEAN, and listen carefully to the
recording to set a sufficient level without distortion.

This means that during recording, the input level indicators should do most of their
“jumping” within the yellow part of the indicator, without reaching the red part. You
can adjust the level of audio files when the recording is finished. Find more informa-
tion on page 48, page 82 and page 91.

Playback Volume

CLEAN's “Output” faders control Playback vol-
ume, i.e. the volume actually output via your
sound card’s out socket.

The actually recorded level of the file on your
hard disk remains unchanged unless you
change it by processing the Track data.

When you move one of the two handles of the
“Input” or “Output” fader pair with the mouse,
the other handle of each pair will follow CLEAN Output level faders
automatically.

If you wish to set each fader in a pair individually, proceed as follows:

Press [Alt] and move the desired fader handle using the mouse.

Both fader pairs can separately be reset to their original values:

Press [Ctrl] and click on one of the faders of the desired fader pair.
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The four Effect sections

CLEAN has four different effect sections: Restoration, F/X and Surround.
Four Tabs, similar to those found in many Windows dialogs, are visible at
the top of the CLEAN window. You can use these Tabs to switch the upper
right part of the window to display any of the four Effect sections.

The four Tabs

R

I Enhencement Mastering | Sl.lrl'ml_l_ﬂ____ L‘clfﬂ" ‘l‘

If you activate this function, Stereo

Use this to the three main restoration On/Off

Z\?f”etgthsagn effects will use their high
or Off quality mode. This increases

the demand for processing
power

Three buttons with general functions are available on all four Tabs:

* By clicking on the general “Effects” On/Off switch, you can switch all active effects
On or Off in one go.

*  Using the “HQ" button, you let CLEAN use other calculation methods for the three
main restoration effects — DeClicker, DeCrackler and DeNoiser. These ‘algorithms’
will in many cases give you better results, but will also consume a lot more of the cal-
culating power that your computer has to offer.

»  The “Stereo” switch is used to switch between stereophonic and monophonic audio
playback.

Except for the Surround setting, which is globally used for all Tracks within
one Project, each Track in the Track list can individually be processed with
the effects. It is therefore possible that you only apply a slight Stereo Spread
effect on Track 1, but use the DeClicker and the DeCrackler on the next
Track. CLEAN automatically memorizes the effect settings that you make. If
you change from one Track to another, CLEAN resets the effect parameters
to the last state memorized for this Track.
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Things the effects have in common

All CLEAN effects combine extremely simple handling with excellent quality.
Except for VST plug-ins (see page 34), the Sound Morph effect (see

page 32), which provide their own editing windows, and the Surround ef-
fect (see page 38) all effects are controlled in the same way, in spite of their
totally different effect on the audio material:

»  Each effect can be activated/deactivated by clicking on its On/Off switch and you
can use its fader to control effect intensity. Depending on the type of effect, values
between 0 (no effect) and 100 (full effect) or -50 and + 50 are available.

[J As always, when using effects and aiming for a professional result, you
should apply the effect intensity individually and purposely. Be as careful
as possible when using the restoration section, otherwise you risk that be-
sides noise and clicks you also remove relevant parts of the useful signal.
This means, if in doubt: less is more!

Fader Reset

¢ Toreset a fader to its default setting, press [Ctrl] on your computer key-
board and click on the respective fader.
Copy and Paste Effect settings

You can use a key command to copy the effect settings from one Track to
another Track. Proceed as follows:

1. Inthe Track list, select the Track whose settings you wish to copy. Simulta-
neously press [Ctrl] and [C] on your computer keyboard.

2. Now select the Track to which you want to apply the effect settings and si-
multaneously press [Ctrl] and [V].
Inputting values from your computer keyboard

Instead of using its fader, you can set an effect by inputting the desired
value into the numeric field to the right of the corresponding fader.

* To do this, double click on the respective field and input the value from
your computer keyboard.
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The Restoration section
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Effect intensity
faders

DeRumbler

DeHummer

The Restoration section
Click on the Restoration Tab to make this section visible.

The Restoration section contains seven effects. You can use the first five ef-
fects to fight clicks, crackles, background noise, predefined noise and sibi-
lants. The other two effects are used to remove rumble noise and mains
hum.

Audition mode switches are available for the first five effects which lets you
control exactly which signal parts will be removed by the effect.

The AutoClean function in CLEAN helps you by analysing individual Tracks
and proposing the best possible settings for the restoration effects De-
Clicker, DeCrackler and DeNoiser. In its pop-up menu you can predefine the
processing intensity (“Light”, “Medium”, “Heavy"). After the analysis proc-
ess, CLEAN automatically adjusts the effects to proposed values.

You can test the result by playing back the Track and make your own adjust-
ments, if necessary.

Here's a short description of what the individual effects do:
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DeClicker

The DeClicker removes single short clicks, as they are often found on vinyl
records. Such clicks can also occur during recording. Then they are often
caused by digital drop outs or by electrical devices (refrigerators, neon
tubes, etc.) that are connected to the same electrical circuit.

DeCrackler

Other than the DeClicker the DeCrackler concentrates on constant back-
ground crackles. These are often audible when you play shellac or vinyl
records, but can e.g. also be produced by equipment of inferior quality.

DeNoiser

This “classic” DeNoiser removes regular background noise as it often oc-
curs on old tape recordings. It can also drastically reduce noise caused by
hardware effects and mixing desks.

FP DeNoiser

This is a DeNoiser that works based upon predefined fingerprint presets.

The FP DeNoiser comes with 20 presets that cover often occurring types of
noise. It has 20 additional preset slots that you can use for your own pre-
sets.

You can create your own Noise fingerprint presets, if CLEAN and the
Wavelab Lite audio editor program, that is part of the CLEAN package, are
installed on the same computer.

Proceed as follows:

1. Start Wavelab Lite and load the audio file that you wish to edit or another
file that contains the same type of noise.

2. In the waveform displayed in the Wave window, select a region which only
contains the noise that you wish to remove, but no useful signal.

3. Open the File menu and select “Save selection as noise fingerprint”.
A dialog appears where you can store the preset into one of twenty preset slots and
name it. As soon as you have completed your settings and confirmed them by click-
ing “Save”, the preset will be available in CLEAN.

(1 You can even create fingerprint presets when CLEAN is active!
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DeEsser

The DeEsser can be used to remove sibilants from the signal, that may oc-
cur on some vinyl record and tape recordings. Use the Audition mode
switch to make sure, you don't remove any parts of the useful signal.

DeRumbler

This subsonic filter cuts off the frequencies below 20 Hz and therefore the
noise caused pick-up needle and groove when a record is played back.

DeHummer

This useful function lets you remove a mains hum noise of 50 Hz (as is typi-
cal in Europe) or 60 Hz (as is typical in the U.S.A.) from the signal. In the De-
Hummer frequency pop-up located in the Preferences dialog, that you can

open from the Options menu, you can define whether you want a 50 Hz or
60 Hz mains hum removed.
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The Enhancement section
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The Enhancement section
¢ Click on the Enhancement Tab to make this section visible.

The Enhancement section contains eight effects. You can use the first six to
increase the harmonic content of a recording, widen the stereo basis, copy
the filtering characteristics of your favourite recording and apply it to other
recordings. You can simulate a tube amplifier and its positive impact on the
sound, add reverb and optimize you audio for playback in a car.

In addition, you can load and edit two VST compatible plug-in effects.
VST is a widespread plug-in standard. Hundreds of VST effects are availa-
ble.

Here's what the individual effects do:

Brilliance

This effect will add second and third harmonics to the sound that you proc-
ess with it. It thus expands the harmonic content of the sound, which will in
effect get more brilliance and a better presence.
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Stereo Spread

The stereo effect of audio material retrieved from older media does not al-
ways meet the expectations: Maybe someone recorded his or her first own
demo tapes without a sound engineer, or maybe a vinyl record suffered from
the many times it was played. The Stereo Spread effect will help to over-
come the resulting “narrow” sound. Stereo Spread widens the stereo basis
of the signal, thereby making the material significantly more transparent and
giving it a more open sound.

[0 Please note that the mono compatibility of the signal might suffer if you
make extensive use of Stereo Spread. In a worst case scenario this could
mean that instruments could completely vanish from the Mix when the au-
dio file is played back in mono. If mono compatibility is important for you,
you should use the Stereo switch in the top right corner of all Effects sec-
tions to test whether the signal is still mono compatible.

Sound Morph

Sound Morph can be used to drastically improve recordings that have a
bland sound.

You let Sound Morph perform its miracle by feeding it with an excellent
sounding piece of audio (preferably of the same musical style).

Sound Morph will analyse the audio and — based on the results of the anal-
ysis — will create a set of effect settings that you can then apply to the dull
sounding Track.

All of this can be done by simply selecting the files and pressing a few
buttons. Proceed as follows:

1. In CLEAN’s Track list, select the file that you wish to improve sound-wise.
2. In the F/X section, activate the Sound Morph effect by clicking on its On/

Off button so that it lights up. Then click on the “E” (Edit) button on the
Sound Morph fader.
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3. Adialog opens. There is a pop-up menu on its left side. Here you must
select a source for the audio analysis.
The audio to be analysed can either be a Wave file (file extension.wav) on your hard
disk or a Live input signal that is played back via your sound card (e.g. a CD track
that you play back from your computer's CD drive.

| File from Disk. -]

v File from Dizk

4. Click the “Analyse” button to analyse the reference audio.
In the display below the “Analyse” button the word “Busy” will appear and flash.

[l Youdon't necessarily have to let Sound Morph analyse a complete piece of
audio, but you can. Experiment! It's worth the effort.

5. To stop the analysis process, press the “Done” button. Then close the
dialog by clicking the “Close” button.
Now you can apply the results of the analysis to any or all Tracks of your current
Project by setting the Sound Morph fader for each Track.

[ Itis agood idea to play back the processed file and let your ears decide,
how much its frequency characteristics should be changed.

Tube Sim(ulation)

This effect simulates the results that using a good Tube Amplifier can have
on the signal.

*  The signal gets a more warm and smooth sound.
*  The signal sounds slightly compressed and harmonic.
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Reverb

This effect simulates Track playback in a room. The proportion between
original signal and room signal always remains the same.

What you change by using the fader is the size and type of the room and
therefore its reverb characteristics.

Car Sim(ulation)

You can use this effect to process Tracks in way that they sound better
when played back via a car stereo system.

What this effect essentially does, is to compress and filter the signal so that
frequencies, that would otherwise be cancelled out by the driving noise, re-
main audible.

The VST effect slots

CLEAN has two effect slots that you can use to load any effect plug-in that
is compatible with the widely used VST plug-in standard. Virtually hundreds
of plug-ins with a great variety of functions are available on the market.
Check your music dealer, the Steinberg web site or the internet.

For VST plug-ins to be accessible from within CLEAN, they must be stored
in a Vstplugins folder that resides within the CLEAN folder.

(1 When you create the folder, make sure to exactly name it: Vstplugins, oth-
erwise the plug-ins will not be found.

Proceed as follows to use a VST plug-in:

1. Activate the On/Off switch so that it lights up. Open the pop-up menu by
clicking on the downward pointing arrow. Then select the desired plug-in.

sternalizer
FuzzBox
StereoEcho
Wunderverb3
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2. Click on the “E” button to bring up the Edit window of the plug-in where
you can make the desired settings.
Most VST plug-ins have their own Edit window, few don't. For the latter type,
CLEAN creates a simple edit dialog.

Lo Karlette

Uolume Damp | Uolume Damp volome Tamp:

39 ©% 90

Pan  Feadback Pan  Feed

Time L ]
samples

\iidth 0.500000 m
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Feed b 0-00000 |———— F——
sum <+dir

Two different Edit windows.
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The Mastering section
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The Mastering section

In the professional audio sector, the process of optimizing and finalizing au-
dio before it is transferred to production is called Mastering.

*  Click on the Mastering Tab to make this section visible.

The Mastering section contains four effects. These can be used to change
the playback speed and with it the pitch, correct certain phase errors, compress
and thereby level out the signal peaks in different frequency bands and increase the
average volume of a recording.

Here's what the individual effects do:

Vari Speed

This effect lets you change the tempo and with it the pitch of a Track. Vari
Speed works in real time and re-samples the audio. You can pitch a Track
up or down by up to two semitones. Its tempo will change accordingly. You
can therefore use this effect to correct false tempi or pitches caused by the
differing basic playback speed of different Cassette recorder models. DJs
will also find Vari Speed handy to adjust the tempo or the pitch of two re-
cordings that they wish to play one after another.
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Phase Correction

This is especially useful when you record Tracks from old tapes. If the angle
between the tape head of your recorder and the tape (azimuth) is not en-
tirely correctly adjusted, the playback signal suffers. It is either strong on
one channel and weak on the other, doesn't have sufficient treble or the tre-
ble seems to come and go.

Try this effect to improve the material that you have. It does not perform mir-
acles but can help to improve the quality.

Multi Band Compressor

The Multi Band Compressor is levelling out peak levels. These are attenu-
ated which decreases the dynamic bandwidth, thus the difference in level
between the loud and the soft levels. This makes it possible to increase the
average level and reduce the risk of digital clipping.

In the Multi Band Compressor, the signal is divided into three fixed fre-
quency ranges (“Hi", “Mid" and “Lo"), which are processed separately. This
improves the flexibility and sound quality considerably.

You can test the effect the Compressor has on each frequency range by us-
ing one of the three Solo buttons.

Loud(ness) Max(imizer)

This is a very special effect. You can use it to increase the average volume
of a recording.

Imagine, you have recorded a Track that contains music with a wide dy-
namic range. That is, the music contains a few very loud parts, but also very
low parts. During recording, you have taken great care that the few loud
peak signals did not cause distortion.

Now you find that — compared to the peaks — the rest of the music is not
loud enough. Try Loud Max to level out the different levels. It will make the
material sound more dense.

Where and how you should use this effect depends on the type of music
and your taste. If a wide dynamic range is part of the musical character of a
recording — as is often the case with classical music — then you should ei-
ther refrain from using Loud Max or only use it subtly.
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The Surround section
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The Surround section

¢ To bring up this section click on the Surround Tab in the top right of the
CLEAN window.
The Surround section can be used to create stereo compatible Surround re-
cordings. In other words: Here you can turn a normal stereo recording into a
Surround recording with spatial sound characteristics which can also be
played back via a normal stereo system.
First a little theory:

Same as all widely used Surround formats, CLEAN's Surround format in-
tends for a left, right and center speaker, each controlled via a separate
channel. In stereo format, the two speakers left and right do by the way also
create a “front center phantom signal”.

Two more speakers, that are controlled via a common fourth channel, are ar-
ranged in the rear of the listener. For compatibility with conventional tech-
nology, the four channels are combined as a stereo signal. To do this, the
Surround signal is being phase-shifted and placed in both stereo channels.

The center signal is created by combining the stereo channel signals.

The surround channel signal is reverse phase-shifted, then added to both
stereo channels and isolated during the decoding process. When played
back via a conventional stereo system without decoder, the Surround signal
parts are cancelled out to ensure stereo compatibility.

CLEAN / CLEAN PLUS
ENGLISH - 38



Using the Surround section

The settings described hereafter can be used to adapt Surround playback
to your individual monitoring setup. It is after all not uncommon that speak-
ers can not be positioned in the optimal places for practical reasons. This
can be taken into account with this method.

1. Switch on the Surround section.
The switch is located in the top right of the Surround section.

2. Use the Surround level fader at the bottom left of the Surround section to
distribute the volume level between the front and rear speakers.
This is graphically indicated by a red rim.

3. Drag the individual speaker symbols to positions that correspond to the
desired or available monitoring positions. To do this, click on each speaker
symbol, hold down the mouse button and move the mouse to the desired
position. Then let go of the mouse button.

When you drag, the distances in meters and the angle values in degrees between
the speakers and the listener are displayed for all speakers.

[0 The Surround settings do always apply globally to the whole Project.

The distance between the listener and the speakers can be set to values
ranging from one to ten meters. You can define the maximum possible dis-
tance in the Preferences dialog on the Options menu. In this dialog, you can
also switch the measurement unit used to define the speaker distances from
meters to feet and inch.
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The Equalizer

CLEAN includes an 8-band Graphic Equalizer with fifteen fixed and fifteen
user-definable Presets.

The Equalizer is located in the middle of the CLEAN window below the
IntelliAssistant.

You can separately set each of its eight filter bands. By moving one of the tri-
angular fader handles up or down, you increase or decrease the level of the
corresponding frequency band within the overall signal by up to +/- 12 dB.

You can also make Equalizer settings by posi-
tioning the mouse cursor onto the Equalizer
display, pressing the mouse button and drag-
ging the mouse.

TRtaTATSIaERnt ).

You do thus draw in a new Equalizer curve.

The Equalizer section
The “EQ" button, located below the

Klagsik MonsterBass - X R .

Pap Equalizer section, is used to switch the
Disco Equalizer On or Off.

Fock. If you click on the downward pointing
Techno arrow head next to it, a pop-up menu
Vocals appears, where you can select any of
gass, High the available Equalizer Presets.

M?;: The fifteen Presets on the left side of
High the menu are fixed. The Presets that
Eriliance you create yourself will wind up on the
Loudness right side of the menu.

[Eatans The name of the currently active Preset
AL is always displayed in the field to the
A right of the “X” button.
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Creating an Equalizer Preset

To create your own Preset proceed as follows:

Activate the Equalizer by clicking on the “Equalizer” button.

Start playback and move the Equalizer faders up or down until you'’ve got
the sound right.

Double click on the name field to the right of the “X” button and name your
Preset.

Click on the “Return” symbol button.
The right part of the pop-up menu opens.

Click on the desired slot where your new Preset should wind up.
If the slot already holds a Preset, this will be overwritten.
Deleting an Equalizer Preset

If you wish to delete any of your Presets, proceed like this:

Click on the “X” button.
The right part of the pop-up menu opens.

Click on the Preset that you wish to delete.
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The Waveform display
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Fader for moving the visible part of the Waveform display

Controls, upper row from left to right:

Current Track Time, Zoom out, Zoom in, Fade in, Fade out, Time
selected within Track, Automarker Analysis switch, New Marker,
Delete Marker, Create Tracks function.

Controls, lower row from left to right:
Processing Time, CPU Load, Accumulated time of all Tracks together,
Remaining time still available on an 80 minutes CD-R.

The Waveform display shows a graphic waveform of the Track that is cur-
rently selected in the Track list. It is in this display, where you can determine
where the Track starts and ends as well as whether it should have a fade in
or fade out, and the length of that.

Setting the Track length - The Start and End Markers

¢ Drag the green Start Marker (the lower dot on the left side) with the mouse
to determine a new start position. This might e.g. be useful if the starting
point of the audio file is not identical with the acoustic starting point.

*  You can determine the end of the audio file in a similar fashion: Use the
mouse to drag the red End Marker (the lower dot on the right side) to the
desired position.

The “Selected time" display informs you about the current length of the Track, as de-
fined by the Start and End Marker settings.

¢ Toreset all Markers to the edges of the waveform, hold down the [Ctrl] key
and click on the Waveform display with the left mouse button.
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[l The Start and End Markers disappear, once an imported Track or one that
you have recorded with CLEAN has been processed or manually been set
to “ready” status - see “Processing the Tracks” on page 46. If you manually
set a Track to “ready” status by clicking its Track number with the right
mouse button, then its Marker and Fade-in/out settings are not being used
as nothing has been processed. You can of course re-define the Start/ End
Markers and the Fade-in/ out Markers for each Track at any time. To do so,
click on its Track number with the right mouse button. If it was processed
or manually set to “ready” status before, - indicated by the green color of
its Track number - then it will be set back into “not processed” status - in-
dicated by a red Track number.

Effects can be applied on the same Track many times.

The Fade-in and Fade-out Markers

You can use the Fade in and Fade out Markers to gradually increase (fade
in) and/or decrease (fade out) the volume within a definable time frame at
the beginning and at the end of the audio file.

¢ Tofade in a Track, drag the Fade in Marker (the upper green dot on the left
side) to the right until the fade in has the required length.
The length of the fade in hours/minutes/seconds is shown in the “Fade in” field.

¢ If you want to fade out a Track, drag the Fade out Marker (the upper red
dot) to the left until the fade out has the required length.
The “Fade out” field below the Waveform display informs you about the exact length
of the fade in hours/minutes/seconds.

Instead of creating fades with the mouse, you can set them by inputting the
desired value into the “Fade In" and “Fade Out" fields below the Waveform
display.

* To do this, double click on the respective field and input the value from
your computer keyboard.
Values must be input in the format hours:minutes:seconds.

¢ Toreset all Markers to the edges of the waveform, hold down the [Ctrl] key
and click on the Waveform display with the left mouse button.

[0 You can use the “Undo” function on the Options menu to undo the last 100
Fade in/Fade out Marker changes.
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Zoom - Changing the size of the displayed Waveform

=20

¢ If needed, you can use these two buttons to zoom in or out on the wave-
form in the Waveform display. As an alternative, you can also use the [+]
and [-] keys on your computer keyboard.
When you have set a high magnification, the waveform might not be completely visi-
ble in the Waveform display. Then you can use the slider under the display to move
the visible part of the waveform.

* To change the zoom factor dynamically, position the mouse cursor within
the Waveform display, hold down [Shift] and drag up or down.

¢ To make the whole Track visible, hold down [Alt] and click once within the
Waveform display.

The AutoMarker functions

Material that has already been recorded can also be split into individual
Tracks later. This can be done both automatically and manually. The four Au-
toMarker buttons on the lower right-hand side of the Waveform display can
be used to insert, delete and edit Markers as well as for splitting the audio
material into individual Tracks. The “AutoMarker” and “Create Track” func-
tions analyse the audio data based on the settings that you make in the
“Preferences” dialog of the Options menu.

Button Function

The selected audio Track is analysed for silence. Analysis
1 .Iul:nHBr-‘Er ) follows the settings that you have made in the “Preferences”
: dialog of the Options menu.

A new Marker is inserted at the current playback position.
This function can also be used during playback.

The last selected Marker is deleted. This Marker has a
different colour than the others. If you hold down [Shift],
all Markers are deleted.

Creata Tracks according to the settings you have made in the
“Preferences” dialog of the Options menu and Track list
and Waveform display are updated.

- The current audio Track is split into individual Tracks
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Markers can also be inserted manually (with the mouse or by pressing the
[Insert] key), moved (with the mouse) and deleted (by clicking on them with
the right mouse button).

Markers in the Waveform display. The last selected Marker is on the right.

Available disk space

This display informs you how much space you have left on your hard disk.
The yellow bar represents the relative space on the storage medium that
you have selected under “Select temp file directory” in the File menu (see
page 81). In the field next to it you can see how much space is left in terms
of hours/minutes/seconds.

[0 Importing Tracks in CLEAN is not limited to the total playing time of an
Audio CD (up to 80 minutes). You rather can exceed this time limit, e.g. to
save your restored audio data onto a DAT cassette (longer playing time) in-
stead of on CD.
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Processing the Tracks

Before you can actually turn your selection of Tracks into an Audio CD,
CLEAN must calculate the effect settings you have made and create a new
audio file that includes them.

There's one exception: if you wish to burn unchanged Tracks to CD-R, then
you can manually set them to “ready” status.

All Tracks that are ready to be recorded onto CD have a green Track
number. You can even re-define the Start/End and Fade in/out Markers after
the Tracks have been processed. See page 43.

* To process the currently selected Track, please click on the “Process this
Title” switch, located below the EQ section in the CLEAN window. If you
wish to process the complete Project, click on the “Process” switch. If you
wish to interrupt processing for any reason, just click the “Cancel” switch.
The data that has already been written to the disk during the processing will automat-
ically be deleted.

[J Calculating the effect data needs additional hard disk space. Make sure
that enough free space is left on your hard disk: For each Track to be calcu-
lated, you will need as much additional free space as the Track already
uses on the disk.

You can also use CLEAN to burn unchanged Tracks onto CD-R:

¢ If you right-click on a Track number, the number will change to green
(“ready” status) and the corresponding original Track can be recorded onto
a CD without having been processed by CLEAN. To set all Tracks into
“ready” status without processing them, hold down [Ctrl] on the computer
keyboard and click on any Track number.

[l The “ready” status of a Track can at any time be re-defined by clicking on it
with the right mouse button. A red Track number indicates that the Track
has not been processed, a green number that it has or has manually been
set to “ready” status.

The Process Time display

During the processing, this display informs you how long it will presumably
take until CLEAN finishes processing the current Track.

(GE————
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Current Time and Remaining Time CD-R

These two displays at the bottom of the CLEAN window are meant to facil-
itate your overview of the current Project.

The “Current Time" display shows the total time of all Tracks that are currently in the
Track list. If the total time exceeds the recording time available on the CD-R, then the
value is displayed in red.

The “Remaining Time CD-R" display informs you how much free space is left on the
CD-R. If the total time of all Tracks in the Track list exceeds the total available time on
the CD-R, the surplus time is displayed as a negative value.

In this case, use the Start and End as well as the Fade in and out Markers
to shorten longer Tracks.

CPU Load

Processing the effects in real time puts a
heavy workload on the processor. How

many effects CLEAN can actually calcu-
late during playback, depends on the power of your computer processor
(CPU). The “CPU Overload” display shows you how much of the available
processor power is consumed by the current calculations. The more to the
right the “CPU Overload” bar moves, the greater the workload for the CPU.
If the bar completely fills the display, then the processor has reached its
peak performance. As a result, audio file playback will suffer from interrup-
tions and clicks.

You should then deactivate single effects until the “CPU Overload” bar re-
turns to a normal position again and there are no interruptions during play-
back.

How you can use all effects without having a powerful processor is
described on page 84.
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Maximum Level by Normalizing

While analog systems generally show a relatively tolerant behaviour when
fed with signal peaks higher than 0 dB, a digital system for technical rea-
sons responds to levels above 0 dB by creating very unpleasant distortions,
called digital clipping.

Digital recordings with a very low level — on the other hand — suffer from a
low resolution and therefore from background noise.

The solution to the problem consists of two components:

¢ When recording, you should make sure that the recorded signal has a suf-
ficient level. This, however, should never exceed 0 dB, as that would result
in a distorted signal.

¢ CLEAN has three Normalize functions that you can use to optimize the
level of a recorded signal.

The Normalize function searches an audio file for its highest peak level. It
then calculates the difference between the highest dB value it found and

0 dB (the highest level possible before distortion starts to occur). Finally,
Normalize raises the level of the complete audio file by the level difference it
found.

Normalize can of course not differentiate between background noise and
useful signal, but it adds no noise itself. If you thus normalize an audio file
that already has a fairly sufficient level, you will often notice that it still got
more punch.

The recording is simply louder after Normalizing. The Normalize function is
also useful to bring the levels of several Tracks into line that you want to put
on one CD-R.

[0 We recommend that you only use the Normalize function after you have
completed processing CLEAN’s effect settings. If you would normalize
first, then the highest level in your audio file would already have a value of
0 dB. As some effects are likely to further increase the level, this would in-
evitably lead to ugly sounding digital distortions. Therefore please keep in
mind: process first - then normalize!
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Normalizing one or all Tracks

This is how you normalize one Track in your Track list:

1. Select the desired Track in the Track list by clicking on it.
The corresponding line in the Track list will be highlighted.

2. Select “Normalize selected Track” on the Normalize menu.
A dialog box appears, where you can confirm the action by clicking “Yes” or cancel
it by clicking “No". If you click “Yes”, the calculation starts immediately.

This is how you normalize all Tracks in your Track list:

¢ Select “Normalize all Tracks” on the Normalize menu.
A dialog box appears where you can confirm the action by clicking “Yes” or cancel it
by clicking “No”. If you click “Yes", the calculation starts immediately.

Meta Normalizing all Tracks

The Meta Normalizing function can be used to create an equal average loud-
ness for all Tracks in the current Project. If you don't use this function and
record Tracks onto CD that have a different loudness, you must adapt the
volume setting to the loudness of the currently played Track. You can pre-
vent this by using Meta Normalizing.

¢ Select “Metanormalize all Tracks” on the Normalize menu.
The function starts immediately. The calculations can take some time. When they are
finished, am alert informs you accordingly.

[l This functions should be the last you use before recording onto CD.
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Recording the CD-R

CLEAN provides two different CD formats for recording: Audio CD and

Data CD.

*  CDs in audio format contain audio data - e.g. music — and can be played back in Au-

dio CD players or CD-ROM drives.

+  Data CDs in ISO format (i.e. CD-ROMs) can contain different data formats — e.g. MP3
files. The funny thing is that the files may very well be audio files. But here, they are
stored in a way that a computer operating system recognizes them, but most Audio CD
players don't. Some DVD and MP3 hardware players are able to play back Data CDs.
You can e.g. use this format to create extensive compilations of your MP3 files.

Creating an Audio CD

When you have prepared all files in your current project by using the
processing and possibly the normalizing functions or if you have not proc-
essed and instead manually set them to “ready” status, then you can now

record them onto CD.

¢ To do this, open the CD menu and select “Write Audio CD-R...”.
This opens a dialog, as described in the section “The Write Dialog for the CD

Project” on page 51.

Creating a Data CD

Proceed as follows:

1. In the CD menu, select “Write Data CD...”.
The corresponding dialog opens.
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o1

[ Flename

[ Size

Wave
02 Wave
a3 Wave
04 Wave
Wave
0 Wave
i Wave
08 Wave
03 Wave
0 Wave

el b facclx be] x|

BT T T T

CLEAN / CLEAN PLUS
ENGLISH - 50

D:ACleandProjects\Fecarcings\Tille_0Z wav
D:\CleandProjectstAecorings\Tille_04.wav
D:\CleandProjects\R ecordingshTile_05 wav
DAACleandProjects\Fecarcings\Tille_0G.wav
D:\CleandProjects\Aecordings\Tille_03_3way
D:\CleandProjects\R ecordings\Tile_03_dway
DA\CleandProjects\Aecordings\Tille_09_5.way
D:ACleandProjects\Resordings\Till_0G_6.way
D:\CleandProjects\Recordings\Tile_013_7.way
DAACleandProjects\Fecardings\Tille_10wav

ssze00ake =l
2628804 KB
497604 KB
4182404 KB
A0416.04 KB
4303604 KB
4182404 KB
4051204 KB
3383004 KB
4054.04 KB

e

34331 ME (10 files)




2. Use the buttons at the bottom of the dialog to add the desired files.

3. If you also wish to add the files listed in the track list, click the “Get
Project” button.
This doesn't change the CD format to Mixed Mode. Instead, the files are simply

added as computer files.

[l Ifyou close the dialog before writing the CD, the list will be deleted.

The total file size of all files in the list is displayed in the lower right corner of
the dialog. Make sure that it doesn’t exceed the space that is available on
the empty CD-R in your CD recorder.

4. If necessary, switch on the CD recorder.

5. If you have edited the list as desired, you can click the “Burn” button to
start the CD writing process.
This opens the dialog “Write virtual Disc” where you can make additional settings for
the writing process.

The Write Dialog for the CD Project

£% CD Text

Tltlesl

Altistl Artist

Ok | Cancel |

When you select “Write Audio CD-R..." on the CD menu, the “CD Text" di-
alog will be displayed first, and you can insert a CD title and the artist’s
name.

When you have done this and clicked on “OK?", the “Write virtual Disc” dia-
log appears. This can also be opened by clicking the “Burn” button in the di-
alog “Write Data CD...".

Here you can make all the necessary settings for the CD to be recorded.

[
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:’ Projekt schreiben

Zielgerate:

Schreiben I
Schliefen |

Einztellungen. .. |
Medium Infa... |

Geschwindigkeit: |16% (2.822 kB/s)

LD schliefen: I Medium schlisfen

"
Schreibmethode: | Digc at Once j
I-
"

Simulation: IKeine Simulation

Standard |
[~ Auf Festplatte schreiben
I Eiel Bl rack d e SehreberiherEriter Enweitert |

Setting Description

Write The CD writing process is started.

Close The dialog is closed.

Settings This opens a dialog where you can make settings for your

CD recorder. The contents of this dialog depends on the
CD recorder used.

Disc Info If a CD-R is in the CD recorder, you can use this to get
information about its size and available space.

Write Speed Here you can select a Write speed supported by your CD
recorder.

Write method ~ Here you can select a write method supported by your CD
recorder. If you want to write a “real” audio CD, select
“Disc at Once". If you want to write several sessions on
one CD, select “Track at Once".

Closing method Here you can select a closing method.

Simulation Here you define, if and how a simulation is performed
before the actual writing process. Simulating the writing
process lets you find out whether the writing process will
be successful, or if problems might occur.
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Write to hard
disk first

Default

Advanced

If this function is active (ticked), then the writing program
first writes an image file onto your hard disk (which must
have enough free space to hold the file). An image file has
the advantage that the data to be recorded doesn't have to
be converted into CD format during recording, as this is
done when the image file is created. The actual burning
(recording) procedure will therefore be faster and
performed with greater reliability and less risk of
malfunction.

Click on this button to save the current dialog settings as
default. The next time you open the dialog, they will
automatically be set.

If you click the “Advanced” button, the dialog is extended
downwards and you get access to five tabs. These let you
make a number of additional settings for the writing
process.
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The dialog “CD and Burner Info..."”

When you select “CD info..."” on the CD menu, the “CD and Burner Info...”
dialog appears.

In the left part of the dialog you will get information about the medium in your
CD recorder. Here the number of tracks and sessions and the free disc
space are displayed.

In the right part of the dialog you will find information about the selected CD
recorder. You can see, for example, if your CD recorder supports the DAO

(“Disc-at-Once”) CD writing method. In this mode, the entire disc is written

in one pass, without ever turning off the recording laser. DAO support is re-
quired if you want to write Audio CDs.

In this part of the dialog you can also verify, if your CD recorder supports
ISRC codes. The so-called “International Standard Recording Code” was
introduced by the IFPI (International Federation of the Phonographic Indus-
try) and is an identification that is only used on CDs intended for commercial
distribution.

Here you can also find out if an UPC code (“Universal Product Code") is
written. This code is a thirteen-digit catalog number which identifies the
disc.

Furthermore, you can see if a CD text and a CD index can be written and if
the writing process can be simulated first.

If you insert a new recordable CD, click on the Refresh button to update the
dialog.
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Creating CD Labels

The Label Editor allows you to design and print custom labels for your
projects. You can design separate layouts for front, inside, back and disk la-
bels. Both text information and a wide range of image file formats can be im-
ported and edited in various ways.

About Variables and Templates

Every project has a default set of “variables”, text that consists of a short
code string plus a value. Variables provide information about a project, such
as track titles, personal data etc. There are basically two types of variables:
factory and user editable.

Factory variables automatically provide information based on the contents of
a project, and user editable variables can be customized to suit the current
project.

+  Templates are ready-made layouts that will use the information provided by the varia-
bles.

*  You can freely customize the properties of a template layout by using the Label Edi-
tor. Add new images or other objects, delete or edit existing objects etc.

[0 The settings of the CLEAN track list are automatically inserted in the Label
Editor.
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Selecting a Template

The first thing you do before the Label Editor is opened is to select a tem-
plate. As mentioned previously, templates provide some information based
on the current project, and have ready-made layouts:

1. Open the project you wish to create CD Labels for.
2. Select the “Label Editor” option from the Options menu.

3. Adialog appears, allowing you to select a Template for your project.

¥ Select a Label template BB
Pleview List of avaiable templotes

Audo | Dam | Audo+Daa |
CD-Text

Feather3

Film Music

Guitar

Keypboard

Simple - Two columns
Simple - Up22
Speaker

XK Concel 9 Help

To the right in the dialog there is a list of available templates, divided into three
groups “Audio”, “Data” and “Audio + Data". By clicking on the corresponding button
at the top of the list the available templates for the selected project type are shown.
To the left in the dialog, preview images of the front, back and the disk labels are
shown.

VA

4. Select a template, and click OK.
The Label Editor window opens, displaying the CD case front label.

* Ifyou do not wish to use any template you can select “Void” in this dialog.
This will open the Label Editor with empty labels, allowing you to build your own la-
bels from scratch by adding objects, specifying backgrounds, etc.

* You can also save user templates.
This is described on page 69.
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Using the Label Editor

The Label Editor always displays one of the three available views or pages:
the Front, Back or Disk label. You switch between these pages by selecting
the corresponding tabs below the Menu/Toolbar. The layout is completely
independent for each page.

* Please note that the Front Label can either be single or double-sided.
This option is set in the Page Layout dialog on the Printing menu, see page 72.

T Page layout [case front label) [~

Paper height [29.70 cm 3: :l
Paper width m

W Landscape orientation

Mumber of wiews I‘I 3: :l

Size

height [11.95 cm =
width |12.05 cm =5

Ll

Reset to standard values

Herizantal affzet {3 cm =

Ll

Wertical offset |4 cm =

Untitled j |v Ok I K Cancel | % Help
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About the Label Editor Window

The Label Editor displays a frame with the selected label (Front, Back or
Disk) layout. Layouts are made up of editable objects. Objects can be either
images, text boxes, lines or circles. You can also select either an image or
color as background for the layout as a whole.

Horizontal &
Vertical Rulers Front/Back/Disk
(optional) Layout buttons Menu/Toolbar

¥ Joey Steinherg.lab

Background Circle object ~ Text box objects
(with “Show Grid" option selected).
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Basic Object handling in the Label Editor

The Label Editor Tools

Insert Circle, Insert Line

Insert Box with Text Insert Image

@Q\kg_&j & | § Q0% |

Zoom Object Print Label

Selection Tool Zoom In/Out

Tools can be selected in three ways:

*  From the Tools menu

* By clicking the corresponding icon on the Menu/Toolbar

+ By right-clicking in the background area (not an object), and selecting from the con-
text menu that appears

The following Tools are available:

Tool Description

Selection Tool Used to select, resize or move objects.

Zoom Object & This is used to zoom in on a selected object, keeping it in view.
Zoom In/Out The Zoom In/Out zooms the layout as a whole in or out. You

can go back to normal magnification (1:1) by selecting “Zoom
100%" from the Options menu.

Insert Track List This will produce an automatically generated Track List, based
on the tracks belonging to the current project.

Insert box with text Creates a text box object.

Insert Circle This will insert a circle or ellipse object.

Insert Line This will insert line objects.

Insert Image This will insert an Image.

Set background color... Allows you to define a color for the background of the layout.

(menu only)

Set background Allows you to define an image for the background of the

image... (menu only)  layout.
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Selecting Objects

Clicking an object with the Selection tool selects it.

»  Selected objects are indicated by a dotted outline, and square “handles”, which can
be used to scale the size of the object.

+  To select several objects, hold down [Shift] or [Ctrl] and click. Selected objects can

be deselected by [Shift]-clicking.

When several objects are selected, one of the objects will always have “focus”. This

is indicated by red handles. You can move the focus to any of the selected objects

by [Ctrl]-clicking.

T Joey Steinberg.lab * BE M=lE
Piinting Tools Dbjects Optionis | WQ Ollm & « |l

| |0 Case back label | @ Case disk label |

Two objects selected, with the upper having the focus.
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Resizing Objects

If you click on a handle of a selected object, the pointer changes to a dou-
ble arrow, indicating the directions you can drag.

Images or circle objects will be scaled, whereas dragging the handles of text box ob-
jects will resize the size of the box, not the text itself.

You can also right-click an object and select “Edit position and size...” from
the context menu.
A dialog appears, allowing you to edit size (width and height) numerically, in cm/mm.

Inserting new Objects

Inserting new objects is done by selecting the corresponding tool, and
clicking and dragging in the layout.

When you release the mouse button, a dialog appears, allowing you to define basic
properties for the inserted object. Note that this does not apply to Image objects,
where instead a standard file dialog appears. The Edit Properties dialog is also se-
lectable from the Objects menu and by right-clicking objects and selecting the corre-
sponding option from the context menu. See page 63 for a description of the various
items available in the Edit Properties dialogs.

Inserting a text box object.

Deleting Objects

To delete objects, simply select them and use the [Delete] key.

Copy/Move Object

If you manually move an object with the right mouse button pressed, a small
pop-up menu appears when you release the button allowing you to either
select to copy the object to the new position or to move it there.
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Positioning Objects
There are several methods you can use to position objects:

¢ Manually
You can drag objects using the Selection tool.

¢ Automatically in relation to the layout frame
By right-clicking an object, you can automatically center the placement of an object
either horizontally or vertically by selecting the corresponding item from the context
menu.

* Automatically in relation to other selected objects
See page 67.

¢ Numerically
If you select “Edit position and size...” from the Objects (or context) menu, a dialog
opens where you can position the object (selected with focus) numerically. You
specify the position from the left side and the top of the layout frame, in cm/mm.
Click “Apply” to apply the position change without closing the dialog.

T Edit position and size

Left |E.3B cm 3: :I Wwiidth |2.s4 cm 3: :[
Top |8.38 cm 3: :l Height I‘I.S‘I cm 3: :l

V ak. I x Cancel | Apply |

About the Grid, Rulers and Magnetize Options

On the Options menu, you will find two items, “Show grid” and “Show rul-
ers”. If these are ticked, the background of the layout will show a grid con-
sisting of little dots, and also vertical and horizontal rulers that show the
current position of the mouse pointer. Both these items help you to position
objects with fine precision in the layout. The grid spacing can be specified in
the Preferences dialog on the Options menu.

You can also use Magnetize so that objects will snap either to grid posi-
tions, to other objects or to the frames limits (or all three), by selecting the
corresponding Options menu item.
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About the Edit Properties Dialog

The Edit Properties dialog can be opened in three ways:

* By selecting an object and selecting “Edit properties..." from the Objects menu.
»  Byright-clicking an object and selecting the same item from the context menu.
* By double-clicking an object.

The contents of the dialog vary depending on the object type.

Text Box Properties

T Box with text = E
[~ Border — Text
Thickness |1 =iel S ax appeal =l

L0 [e] -

5 Riournded corrers

Gize lﬂ] “
L o

¥ Background
’7 coor [ Fant | | Vrabes

r Orientation

1+ Horizontal [multiple lines possible]
W Enable word wiapping
1 Wertical top down (single ine only)]

™ Wertical down top [single ine only)

T Jugtify Left € Justify Top
¥ Center horzontally € Center verically
 Justify right © Justify bott
X Concel I @ sopy | Listify rigl uistify bottom
Margin between frame and text |0.05 cm 3: :
v 0K

= Dra dottedlins after text

The following properties can be set for a Text box object:

Property Description

Border Options Here you can define whether or not the Text box should have a
border surrounding it, and to set the thickness of the border. In
addition, the Text box corners can be rounded. The Size of the
rounded corners can also be set, the higher the number the rounder
the corners will be.

Background Sets the background color of the Text box. By clicking in the Color
Color field, a standard color dialog appears where you can pick a color.
Text Field This is where you type in the text that will appear in the Text box.
Font... This opens a standard font dialog, where you can select font type,

text format, text color, and text size etc.
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Property Description

Text Orientation Here you can set the orientation of the text. Select between
Horizontal, Vertical top down, or Vertical down top. In addition you
can set whether the text should “wrap” or not. If text wrap is on the
text orientation will adapt according to the size of the text box.

Text Justification This allows you to set the text justification, i.e. the position of the text
in the text box. It can be centered horizontally, or justified to the left
or right sides. It can also be centered vertically, or justified to the top
or bottom of the text box.

Text Margin Allows you to set the margin between the text box frame and the
text.

Draw dotted line If you select left justification and deactivate the option “Enable word
after text wrapping”, there is an additional option to draw a dotted line after
the text, which is otherwise greyed out.

Variables... If you select this, you can pick a defined variable and enter this code
in the text box. If you for example have defined a variable for the
name of a composer, you can select this variable in the dialog and
then chose either “Import Code” or “Import actual text”.

In both instances, the composer name will appear in the text box.
The difference is that if you later redefine the variable, the text
imported as code will automatically change for every instance it is
used in this project, whereas importing as text will not reflect any
changes made to the variable. If you click “Edit”, the Edit Text
Variables dialog opens, allowing you to edit and define user
variables. This is described on page 70.

* Note: If you have used the “Import Code” function for an object, you can
choose whether the actual code or the resulting text will be shown in the
Label Editor.

This is done by selecting the corresponding item on the Options menu.

Circle Properties

The Circle/Ellipse properties dialog can set the following parameters:

Property Description

Border Options Here you can define whether or not the Circle should have a border
line surrounding it, and to set the thickness of the border line.

Background Sets the background color of the Circle. By clicking in the Color field,
Color a standard color dialog appears where you can pick a color.
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CD Track List Properties

T CD-Audio Track List =

— I Border

Thickness I‘I 3: :l First track I‘I 3: :l
T - Last track Igg 3: :l

— Range

=} Rounded cormers — Main Line
Size |5 3: :l Fari... |
I Background — I~ Draw dotted ine between title and time
(£ I:I
— ExtraLine
argin between frame and text ||
ID.DE 3: :I .
el Fant... | Wariables... |
V Ok, x Cancel | Apply | %

The CD Track list is auto-generated by variables, taking the information from
the tracks included in the project.

The CD Track List Edit Properties dialog has the following options:

Property
Border Options

Background
Color

Range

Main Line

Extra Line

Text Margin

Description

Here you can define whether or not the Track list should have a
border line surrounding it and set the thickness of the border line. In
addition, the Track list corners can be rounded. The Size of the
rounded corners can also be set, the higher the number the rounder
the corners will be.

Sets the background color of the Track list. By clicking in the Color
field, a standard color dialog appears where you can pick a color.

This allows you to define the First and last Track numbers to be
included in the generated list.

Here you can set the option of drawing a dotted line between the title
and the track time, and to define the style of the text (see Font...
below).

Here you can either write in extra information manually, or pick a
variable (see Variables... below). You can set up a different text style
for the extra line (see Font... below).

Allows you to set the margin between the Track list frame, and the
text.
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Property
Font...

Variables...

Description

This opens a standard font dialog, where you can select font type,
text format, text color, and text size etc. for the Main or Extra line.

If you select this, you can pick a defined variable and enter this code
in the Track list. If you for example have defined a variable for the
name of a composer, you can select this variable in the dialog and
then chose either “Import Code” or “Import actual text”. In both
instances, the composer name will appear in the Track list. The
difference is that if you later redefine the variable, the text imported as
code will automatically change for every instance it is used in this
project, whether importing as text will not reflect any changes made
to the variable. If you click “Edit", the “Edit Text Variables” dialog
opens, allowing you to edit and define the user variables. This is
described on page 70.

¢ Note: If you have used the “Import Code” function for an object, you can
choose whether the actual code or the resulting text will be shown in the

Label Editor.

This is done by selecting the corresponding item on the Options menu.

Image Properties

This opens a standard file dialog, where you can navigate to the image you
would like to import. The supported image formats are:

*  BMP/JPEG/PCX/PNG/PSD/TGA/TIF and TIFF/WMF/EMF

Line Properties

Here you can define the thickness and the color of the line.
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The Objects Menu

The Objects menu can be selected from the Menu/Toolbar, or opened by
right-clicking an object (context menu). The items on the Objects menu are
greyed out if no object is selected.

If an object is selected, the following Object menu items are available:

Item
Edit properties...

Edit position and
size...

Edit display
condition...

Bring to front

Send to back

Center horizontally
Center vertically
Lock movement
Select all

Select all with the
same size

Description
See page 63.
See page 62.

This allows you to decide whether an object will be displayed or
not, depending on whether a given variable is empty or not.

This brings any object that is partially obscured by another
overlapping object to the front.

This sends any object that partially or completely overlaps
another object to the back.

Centers a selected object horizontally in the layout.
Centers a selected object vertically in the layout.
This locks the position of the selected object.
Selects all objects.

Selects all objects with identical dimensions to the selected
object.

If several objects are selected when opening the Objects menu, the follow-
ing additional items are selectable:

Item

Description

Apply same properties This item allows you to apply properties from the focused

as focused object

Space evenly
horizontally

object to all of the selected objects of the same type.

This distributes the selected objects horizontally, using the top
center handle as a guide. This means that the top center
handle in each selected object will be exactly the same
distance from each other horizontally.

Space evenly vertically This distributes the selected objects vertically, using the side

center handle as a guide. This means that the side center
handle in each selected object will be exactly the same
distance from each other vertically.

Place under each other This will place all selected objects directly under each other.
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Item

Align with focused
object (several items)

Resize as focused
object (several items)

Group/Ungroup

Description

These menu items will align selected objects to the position of
the focused object. You can select to align to any side (left/
right/top/bottom), or to the horizontal or vertical center of the
object with the focus.

These menu items will resize all selected objects to either the
same size as the focused object or to the same width or height
as the focused object.

This will group all selected objects to each other, so that they
will act as one object when selected or moved (keeping the
relative positions to each other). Ungroup deselects the
grouping.
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About Label Sets

You can save as many Label sets as you like for a project. However, when-
ever you open the Label Editor, a new Label set opens which is untitled and
only contains the auto-generated data.

Whenever you have edited layouts in the Label Editor, you will be asked to
save it as a Label Set if you close the Label Editor or exit the program with-
out first having saved your changes. If you don't save, any changes are gone
forever.

¢ ltis important to note that any work performed in the Label Editor is not
saved with the project - it has to be saved separately as a Label Set.

¢ Saved Label sets (with the extension *.1ab) contain all the layout work per-
formed in the Label Editor.
It is, however, undynamic. This means that if you have added to or changed the
Project, these changes will not be reflected in the saved Label Set, unless you save
it as a user template (see below).

Saving a Label Set

To save a Label Set, simply select “Save” or “Save As..." from the File menu
with the Label Editor open and as the active window (on top).

Opening a Label Set

To open a saved Label Set, select “Open..." from the File menu.

Saving a Label set as a User Template

If you have saved a Label set, it can be displayed on the list of available tem-
plates in the “Select a Label Template” dialog. Label Templates are simply
Label sets that reside in designated subfolders in the CLEAN program
folder. The path to the Label template folders (starting from the main
CLEAN program folder) is “Presets\Label\Templates\". Here you will find
three folders: “Audio\AudioData\Data. Place (or save directly) a Label set in
the appropriate folder. It will now appear as a new template next time you
open the “Select a Label Template” dialog.
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Defining User Variables

Apart from the auto-generated data such as CD information, date and time
etc., you can define a number of user editable variables that are local to the
project you are working on. Once you have defined a set of user variables,

this is saved with the current project. To define user variables, proceed as

follows:

1. Open the project you wish to set user variables for.

2. Select “Default text variables...” from the Options menu.
This opens a dialog containing a list of folders similar to the structure in Windows Ex-
plorer.

¥ Edit Text Variables

D escription Current value
Automatic number Editable | %Engineer
@ CD-Text / Aranger [CD] Editable | Zananger®
CD-Text / Message [CD) Editable |%Meszzage®
CD-Text / Song Wiiter [CD) Editable | %5 ongwiiter’
@ Company Editable  ZCompanpi
Date/Time Editable | %Faxi
Email Editable | #Address’
[F Fax Editable | %Phone
File Humber Editable |%Project¥
Files and folders at the raot of the data-CD Editable | %Copyright?z
[F Mame Editable | %UseiName?
Fhone Editable | %Email%
Total Time [including pauses| Editable | %Performer’ 00"
Track Number Editable  %Composers 00
@ Personal information —
@ Audio OO information
@ Data CD information =l
Mew folder Mew variable | DElete | Formats... |
Impart default variables [from the Options menu) |
[United A ok | R |2 R |

¢ Only the variables in open folders (marked as “Editable” in the Type col-
umn) can be edited.

3. To define a value for a default variable, for example Copyright or personal
information, double-click in the Current Value column for the relevant de-
scription.

A text box opens where you can type in the relevant information.

4. Click OK when done.
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Saving Variable Sets as Presets

Clicking the name field pop-up at the bottom of the window opens a menu
which allows you to save sets of Label variables as Presets. You can then
switch between different presets of already “filled in” variables. A Preset
could typically represent the information belonging to a client you work with
regularly, for example. Naturally, the auto-generated variables will still adapt
to the current project as usual.

Creating new Variables

You can create a new variables, and define a value for them. The new varia-
ble will automatically be put in the currently selected folder (or in the folder
with a currently selected variable). Proceed as follows:

1. Either create a new folder by clicking the “New Folder” button, or select a
folder that you would like to add a new variable to.
If you chose the former option, select the new folder.

2. Click the “New Variable” button.
A new editable variable appears in the selected folder.

3. Double-click in the Description column beside the new variable to open a
text box where an appropriate description can be typed in.
For example “Producer”.

4. Double-click in the Current Value column to enter the relevant information
for the new variable, i.e. the name of the producer.

5. To create a code that can be used to refer to the variable in the Label Edi-
tor, type in an appropriate name beginning and ending with “%” in the
Code column.

To use the earlier example, this could then be written %Producer%.

6. Click OK when done.
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Printing CD Labels

You print your CD labels directly from the Label Editor, either on standard
paper or on specialized CD label papers (usually available in computer pe-
ripheral stores, etc.).

Calibrating the Printer

If you are printing on specialized CD label paper, it is very important that the
printer is “calibrated”, that is, the measurements in the program (for margins,
positioning, etc.) must be exactly the same as the actual results you get
when printing. This is not as important when you print on standard papers
(since the printouts then don't have to fit exactly in specific positions on pa-
per).

To calibrate the printer, select “Calibrate printer” from the Printing menu in
the CD Label Editor. Then follow the steps in the dialog that appears.

[0 You only need to do this once (unless you switch to another printer).

Setting up Page Layouts

The Page Layout dialog contains various settings relating to how the page
layout will be printed. It's important to note that you make Page Layout set-
tings individually for each one of the three label types (case front, case back
and disc label). These are also printed individually.

[0 Ifyou are using specialized CD label papers, these will typically come with
a measurement sheet, showing the exact size and positioning of the la-
bels. You will probably want to use this when setting up the page layouts
for the first time.

Case front label
Proceed as follows:

1. Select the case front label by clicking on its tab.

2. Select “Page layout” from the Printing menu.
The Page layout dialog for the case front label appears.
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M Page layout [case front label) =

Faper height |29.70 cm
Paper width {21 cm

IV Landscape orientation

MNumber of views |1

Size

height [11.95 cm

width |12.05 cm

Horizontal offset |3 crm =

Wertical offset [4 cm —

Reset to standard values

Ll

|Untitied

j |v Ok, I x Cancel | @ Help |

3. Make the appropriate settings:

Setting
Paper height/width

Landscape
orientation

Number of views

Size

Double-sided

Description
This is where you specify the size of the paper used in the printer.

Allows you to specify the orientation of the papers: “lying down”
(Landscape) or “standing up”.

Lets you print more than one instance of the label on the same
paper. For example, if you are printing the case front label on
standard paper, you can usually fit two views on the same paper
(depending on the paper size), which may be useful if you are
making several copies and want to save paper.

This is the size of the label. Usually, you should keep the default
values (set to fit a standard “jewel CD case”). If you have
adjusted the values, you can bring back the standard size by
clicking the “Reset to standard values” button.

When this is activated, the label will include both the front and
the inside of the front cover label. Note: You will probably have to
use Landscape printing to fit a double-sided layout on paper
(depending on the paper size).

After printing a double-sided front cover, you need to fold the
paper at the correct position.
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Setting Description

Offsets These settings determine the positioning of the label on the
printed page. This is important when you are printing on
specialized CD label paper. Note:

If you are printing multiple views, you make independent Offset
settings for each view. To make settings for a view, you first need
to select it by clicking on its object in the preview display above
the Offset values. A selected view is indicated by a coloured
object in the display.

4. If you like, you can save your settings by using the pop-up menu in the
lower left corner.
This is especially useful if you have made settings for printing to specialized CD label
paper. Once you have set everything up OK, you can save your settings for use next
time you need to print labels. Saved settings are accessed by using the “Explore pre-
sets...” item on the same pop-up menu.

* You can also store settings temporarily, which is handy when experiment-
ing with different layout settings.
To restore a temporarily stored setting, use the Restore items on the pop-up.

5. When all settings are made, click OK to close the dialog.
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Case back label

Proceed as follows:

1. Select the case back label by clicking on its tab.

2. Select “Page layout” from the Printing menu.
The Page layout dialog for the case back label appears.

T Page layout [case back label) [}

X

Paper height |29.70 cm

Paper width |21 cm

Jale el
L«

™ Landscape onigntation

MNumber of views |1 3: :I

— Main part
(45} height [11.78 cm =7
width [13.80 em =5~
— Side part
width ID.BE cm 3: :I
Reset to standard values I
Horizontal offset |2 cr ~

Vertical offset |3 cm

[E |

| Urtitled

d | V ak. I x Cancel | @ Help |

3. Make the appropriate settings:

Setting

Paper height and
width

Landscape
orientation
Number of views

Main part

Side part

Description

This is where you specify the size of the paper used in the
printer.

Allows you to specify the orientation of the papers: “lying down”
(Landscape) or “standing up”.

Lets you print more than one instance of the label on the same
paper.

This is the size of the main part of the back label. Usually, you
should keep the default values (set to fit a standard “jewel CD
case”). If you have adjusted the values, you can bring back the
standard size by clicking the “Reset to standard values” button.

Allows you to specify the width of the side labels. Again, usually
you should keep the default values.
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Setting Description

Offsets These settings determine the positioning of the label on the
printed page. This is extra important when you are printing on
specialized CD label paper. Note:

If you are printing multiple views, you make independent Offset
settings for each view. To make settings for a view, you first
need to select it by clicking on its object in the preview display
above the Offset values. A selected view is indicated by a
coloured object in the display.

4. Use the pop-up menu in the lower left corner to save your settings, store/
restore settings temporarily, etc.
See above.

5. When all settings are made, click OK to close the dialog.
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Disc label
Proceed as follows:

1. Select the disc label by clicking on its tab.

2. Select “Page layout” from the Printing menu.
The Page layout dialog for the disc label appears.

T Page layout [disk label)

Paper height |29.70 cm
FPaper width {21 &m

™ Landscape orientation

Mumber of wiews |1 3: :l

Disk size

Inner diameter |4 cm

Outer diameter {11.70 cm

Reset to standard values

Harizontal offset |5 cm =

‘ertical offset |4 cm =

[E |

IUntitIed d | V ak. I x Cancel | @ Help |

3. Make the appropriate settings:

Setting Description

Paper height and This is where you specify the size of the paper used in the

width printer.

Landscape Allows you to specify the orientation of the papers: “lying down”

orientation (Landscape) or “standing up”.

Number of views Lets you print more than one instance of the label on the same
paper.

Disc size Allows you to specify the inner and outer diameter of the disc

label. Clicking the “Reset to standard values” button sets the
values to the most commonly used label size.
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Setting Description

Offsets These settings determine the positioning of the label on the
printed page. This is extra important when you are printing on
specialized CD label paper. Note:

If you are printing multiple views, you make independent Offset
settings for each view. To make settings for a view, you first need
to select it by clicking on its object in the preview display above
the Offset values. A selected view is indicated by a coloured
object in the display.

4. Use the pop-up menu in the lower left corner to save your settings, store/
restore settings temporarily, etc.
See above.

5. When all settings are made, click OK to close the dialog.

Printing
Again, printing is done independently for the three label types. However,
there are two settings that are global for all three label types:

1. Pull down the Options pop-up menu and select “Preferences”.
The Label editor preferences dialog appears.

2. Use the “Printing” checkboxes to determine whether the frames around
the labels should be printed, and whether cut markers should be printed
(making it easier to cut out the labels from the printed paper).

Now, you are ready to print:
3. Select one of the label types by clicking its tab.

4. Select “Print” from the Printing menu in the Label Editor window.
The Print Label dialog appears, allowing you to make printer settings, preview the re-
sult and specify a number of copies.

5. Click Print.

6. Select the next label type by clicking on its tab, and proceed from step 3
above.
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Exporting audio in MP3 format

CLEAN can also export audio in MP3 format.

You can use CLEAN to decode an unlimited number of MP3 files.

For license reasons, encoding audio data into MP3 format is limited to 20
encoding processes. An MP3 Update that allows unlimited encoding can
be purchased from Steinberg.

You can thus record or import music from other media/formats (CD, record,
cassette, WAV or MPS3 file), process it with CLEAN and save it as MP3 file.

CLEAN supports a whole range of MP3 quality options. The MP3 process-
ing in CLEAN is based on the original technology of the Fraunhofer Insti-
tute.

Proceed as follows to save Tracks in MP3-Format:

Open the Export-Dialog by selecting “Export audio track as MP3 file...” in
the File menu or by pressing [Ctri]-[M].

Export as MP3 file

Author [ Title: [ Time |
aufgenammen Coconut Radio 00313 | | M cRC
aufgenammen Island in the sun 00244 )
aufgenommen Sky 0032z | | [ Comyight
aufgenammen Bad News 00402 =
impartien One step ahead 0:0354 M Ei]
impotiett Elisabelh's eyes 00439 | | ) Intensity
impotiett Take my place 00402
impotiett Wounded Knee 00355
impotiett Conboysbindians 00345 R
& Momalstast
" Better
© Highest/slon
[ :00:00
Ic'\lrack .
[128 kbps - 44100 Hz Sterea o] [ Encose | Cancel |
T Kbps - 4470 Ha Stersn
2 kbps - 44100 H

tereq

- 44100 H 0
160 kbps - 44100 Hz Stereo
192 kbps - 44100 Hz Steren
224 kbps - 44100 Hz Stereo
256 kbps - 44100 Hz Steren
320 kbps - 44100 Hz Stereo

In the list, select the Track(s) that you wish to export and make the neces-
sary settings (see below).

Click on “Encode”.
The program will start to encode the data and create the desired MP3 files.
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MP3 Options

CRC

Copyright

Original

Intensity

MP3-Quality/
Speed

Bit Rate pop-up

This is an abbreviation for Cyclic Redundancy Checksum. If
CRC is active, then the program adds checksums to the file.
These do e.g. enable an MP3 Player to solve smaller data
glitches that might have happened somewhere during data
transfer. The checksum information helps to reconstruct the
data.

If this is active, a copyright bit per data frame is inserted into
the data stream.

If this is active, the program inserts a bit into the data stream
that indicates that this Track is an original. This can be used to
distinguish otherwise identical Tracks.

By activating this function, encoding takes place in the form of
an intensity stereophony file. A distinct feature of this form of
stereophony is, that the spatial perception in the higher
frequency range is determined by direction and magnitude.
That is why only this information is encoded for each of these
frequency bands.

You can use these three options to apply one of three available
quality levels for encoding in each of the available bit rates (see
below). “Normal” is sufficient for many applications. The

options “Better” and “Highest” should be used for processing
classical or other music with rich harmonic content. True in this
case, as in most: for the best you will have to wait the longest.

In this menu at the bottom of the dialog you can set the desired
bit rate. 96 kbps is mostly sufficient for voice recordings. If you
wish to send music via the Internet, try 128 kbps. Values
between 192 and 256 result in CD-like quality. The setting 320
kbps creates very high quality.
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The Menus

This section contains a short description of all items on the CLEAN menus.

The File menu

New Project...

Open Project...

Save Project

Save Project
as...

Remove
WAV file

Delete
WAV file

Export Audio

Track as WAV...

Export Audio
Track as MP3
file...

Export Track
list as...

Select temp file
directory...

Recent Project
Quit

Selecting this item creates an empty new Project. In the dialog that
opens, select the directory in which you want to save the Project
and give the new Project a name.

Selecting this opens a previously saved Project from hard disk. A
project can also be opened using Drag & Drop; a previously open
Project will then automatically be saved.

This item lets you save the current Project under the name and path
that you have specified when creating it.

This lets you save the currently open Project under a new file name
and path.

Select this menu item to remove the currently selected WAV file
from the Project. This does not delete the file on the hard disk!

Select this function to remove the currently selected WAV file from
the Project and delete it from your hard disk. A safety dialog will
appear. If you confirm the action, the respective file will be deleted
on the hard disk and can not be recovered!

If you select this item, the currently selected Track in the Track list
will be saved to disk as a WAV file. You can specify a new name
and path for it.

This lets you save Tracks as MP3 files. Select the desired Tracks,
encoding quality and other MP3 parameters in the dialog that
opens and set up the desired path under which the data is stored.

This lets you save the Track list entries as an ASCII file (text only)
under a name and path of your choice.

You can use this item to determine the directory in which CLEAN
saves the processed files (those that are written onto the CD-R).

Here you can open the recently used projects.

Selecting this will terminate the program.
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The Options Menu

Undo (Start/End
and Fade in/Fade
out Markers)

Mono playback

Soundcard
settings...

Preferences...

This is a multiple Undo function. The last 100 changes that you
have made to the Marker positions can be cancelled, one by one.

Here you can set which channel should be used for monophonic
playback.

Opens a dialog where you can select a sound card for recording
and playback as well as the number and size of its buffers.

This is where you define which maximum level and how many
seconds of it should be considered as silence. Here you can
also set the distance available for speaker positioning to values
between 1 and 10 meters and the unit type to meters or inches.
You can select one of two Equalizer types and set the automatic
Pause length between two Tracks (0 to 4 seconds).

The CD menu
CD info...

Write Audio CD-
R...

Write Data CD...

Checks the size of the CD-R.

Selecting this item opens a dialog where you can make a number
of settings concerning your CD recorder and start the writing
process. Find more detailed information in the section “Exporting
audio in MP3 format” on page 79.

Selecting this item opens a dialog where you can assemble the
list of files that you wish to record onto CD. Here you can also
make settings for your CD recorder and start the writing process.
Find more detailed information in the section “Creating a Data
CD" on page 50.

The Normalize menu

Normalize se-
lected Track

Normalize all
Tracks

This function finds the highest peak level in the Track that is
currently selected in the Track list and optimizes it to a level of O
dB. The rest of the Track is optimized in equal proportion.

This function finds the highest peak level within each Track in the
Track list and optimizes that to a level of 0 dB. The rest of each
Track is optimized in equal proportion.

[J Please read and respect all copyright information on the CDs or web sites
from which you load Tracks!
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The Import menu

Import WAV/MP3
file...

You can either select this item to import one or several WAV or
MP3 files into the current Project or use Drag & Drop to achieve
the same. MP3 files are automatically converted into WAV format.

Import Tracks from Selecting this item lets you load (“grab”) audio data directly from

CD...

Audio CDs. The data is saved as WAV files. It is a digital copy
that is written to your hard disk as an audio file. A/D or D/A
conversion which could downgrade audio quality does not take
place.

The Help menu

Steinberg on the
Internet

Steinberg Service
on the Internet

About CLEAN

If you have Internet access, a modem and a browser software,
selecting this item will connect you directly with Steinberg’s Web
Site.

If you have Internet access, a modem and a browser software,
selecting this item will connect you directly with Steinberg’s
Service Web Site.

Some information about CLEAN and the people who contributed
to it.
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Working with a less powerful system

One of CLEAN's advantages is that you can pre-listen to the effect of its res-
toration and effect functions in real time before you start to process the actual
data and create a file. The time-consuming calculation process is therefore
only necessary when you are satisfied with the settings you have made.

Pre-listening, however, puts a heavy burden on your processor. It can there-
fore happen that pre-listening to the effect of all effect modules in simultane-
ous action is not possible with your particular system. Especially the
restoration algorithms do need a lot of calculating power. Depending on the
processor type that is installed on your computer, it is therefore possible
that you might only be able to simultaneously pre-listen to a combination of
— say — the DeNoiser and the Stereo Spread effect: When switching on an
additional effect, it might happen that the bar in the “CPU load” display
moves into Overload and playback starts to stutter.

In order to be able to use all effect modules to process one or all Tracks on
a less powerful computer, please proceed as follows:

Let's assume you want to denoise and decrackle recordings from old
records first and then optimize them using the Loud Max effect, but your
computer already went on strike when you switched on the DeNoiser.

1. Inthis case, first only switch on the DeCrackler and search for the ideal set-
tings for each Track that you wish to work on.

2. Click the “Process” switch.
CLEAN will now send all audio files that you have prepared this way through the
DeCrackler and it writes the resulting new files into the CD-R file directory.

3. Now deactivate the DeCrackler, activate the DeNoiser, make the desired
settings for each Track in that and activate “Process” again.

4. Repeat the procedure for each effect module that you wish to use until you
are satisfied with the result.
You can and should of course continue to try and simultaneously use several effects.
Most effects do need considerably less processing power than DeClicker, DeCrack-
ler and DeNoiser.

Another possibility to get an impression of the effect of several modules, run
on a less powerful system at the same time, is to use the “Stereo” switch.
The real time effect calculation of a monophonic signal needs considerably
less processing power than calculating a stereophonic signal.

¢ Set the “Stereo” switch to Off, i.e. to Mono.

[0 When you write a CD-R with CLEAN the data is always recorded in stereo.
The setting of the “Stereo” switch is irrelevant to the writing process.
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Using Wavelab Lite

As already mentioned in the section “The Record Dialog” on page 18, you
have received Wavelab Lite together with CLEAN. Wavelab Lite is a pow-
erful and extremely fast Audio Editor.

In CLEAN, the emphasis lies on restoration sound optimization, Surround
sound, MP3 and Audio CD creation.

Wavelab Lite has its main focus on recording, cutting, optimizing levels, au-
dio clip compilation, crossfades and Mastering including effect editing. This
is work that — in the best of cases — you carry out before you start to restore
your recordings with CLEAN.

This manual section tries to point your attention to the great possibilities that
Wavelab Lite offers for the preparation of audio for further processing with
CLEAN. This section only scratches the surface. We recommend, you dig
deeper by reading the Wavelab Lite manual. It contains a full description.

The Wavelab Lite Work Environments

The three most important work environments within Wavelab Lite are the
Wave window, the Audio Montage and the Master Section.

Wave window
. T

o 2= & | | 3 |1z 1%

4 ] ikl

Whether you load audio from hard disk, record something in WavelLab Lite
or simply drag an audio file into the WavelLab Lite window, the correspond-
ing audio file will always be displayed in a Wave window.
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The window has two window panes. The upper pane is mainly used for over-
view. In the lower pane you can select parts of the waveform, apply tools,
edit the audio data, etc.

The Master Section

The Master Section is the “heart” and is mainly used to prepare recordings
for final mastering (CD, etc). But this section is not limited to this area only.
It allows you to creatively process recordings, whether they are complete
mixes or individual tracks in a multi channel recording.

The pop-up menus on its left side can be used to load and apply effects. In
the Audio Montage window you can then let Wavelab Lite calculate Clips
plus effects and create one or several new audio files.
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Recording audio in WavelLab Lite

Before you use Wavelab Lite to record for the first time, make sure that you
have selected the right audio hardware. If you own several audio cards or
maybe even a Multi I/O card, then select the desired audio input.

1. To do this, open the Options menu and select the item “Preferences”. Then
click the “Audio Card” tab.

Gorosl | 4 Audio Card ] As | B Dy | @ TempoTinesods

— Playback Recarding
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i Preferred Playback Resalution Plapback cursar
& 1Ebit [ Get position from audio driver
20kt Corection [samples) |0 =~
24 bit
24 bit alt

W K I 7 Cancel | G Help |

2. Please check the items selected in the “Recording” and “Playback” pop-up
menus and correct them, if necessary.
If the selected input and output devices are okay, close the dialog by clicking on
HOKU.

3. To prepare Wavelab Lite for recording, click the Record button in WaveLab
Lite’s Transport window.
As an alternative, you can simply push the [x] key in the numeric block on your com-
puter keyboard. This key is called [*] on some keyboards.

ﬁ|“«»ﬂ||:||l:=|. ~—— Record

You will now see the Record dialog:
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4. Please make sure that the little box below the level indicator display is
checked as in the picture above. Only then WaveLab Lite will switch into its
Monitor mode where you can make level settings for your sound card prior
to recording.

5. Also make sure that the Attributes field shows the following setting:
Stereo, 16 Bit, 44.100 (Hz), as CLEAN only supports this file format. If the
field shows a different setting, click the “Attributes” button and make the
appropriate settings.

6. When you set the level, make sure that the signal - except for the occa-
sional peak - does not remain in the red part of the level indicator. If you
don’t, digital distortion might occur. On the other hand, the signal should
not generally fall below the yellow part, as this could lead to a loss in
sound quality, depending on the quality of your audio hardware (the side
noise of the card could become louder than the useful signal).

The Peak Level indicator informs you about the highest peak signal that has occurred
since you have opened the dialog or since you last clicked its reset button.

[0 Please make sure that Peak levels never exceed 0 dB!
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10.

11.

Depending on the sound card you use and its drivers, you might be able to
directly access its Mixer from the Record dialog. To do so, click on the
“Mixer” switch.

If this doesn't work, WaveLab Lite will show an alert and you will have to separately
launch the sound card mixer application.

When you have set the recording level, click the Record button in the
Record dialog.

The “Recorded Time" and “Disk Capacity” indicators at the bottom of the Record di-
alog will reflect the fact that WaveLab Lite has started recording.

Click the Stop button in the Record dialog to stop recording.
In the background, Wavelab Lite installs a new window with a waveform representa-
tion of the recording.

You can now leave the Record dialog by clicking on the “Close” button (the
small open door).

The newly recorded audio file is named “Untitled 1". Before you start to work on the
file, you should first name it and save it to disk by selecting “Save As..." in the File
menu.

To listen to the file, simply click the Play button (the button with the small
green triangle) on the Transport bar.
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Cutting audio files

A recording usually contains a few seconds of silence before and after the

actual audio. These silent seconds unnecessarily waste precious space on
your hard disk, the more, as it is extremely simple to create a pause between
the Tracks in CLEAN without having to invest one single extra byte on your
hard disk. In Wavelab Lite you can easily remove the silent parts of your re-
cording:

¢ Simply use the mouse to select the “empty” part of the recording so that it
looks like this:

L]
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¢ You can change the beginning and end of the selection at any time: Posi-
tion the mouse cursor at the start or end of the selected block, hold down
the left mouse button and drag the mouse to change the size of the selec-
tion.

[l Please make sure not to cut off a part of the useful signal, e.g. a soft Intro
or a fading out reverb, by separately monitoring the selection.

¢ To monitor the selection, click into the Wave window with the right mouse
button and select “Play selection” in the pop-up menu that becomes visi-
ble.
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¢ Toremove the selected block, press the [Backspace] key on your computer
keyboard.

All actions in Wavelab Lite can be reversed by selecting “Undo” in the Edit
menu. You can also “undo the undo” by selecting “Redo” in the Edit menu.

Normalizing files in WavelLab Lite

To achieve the best possible quality in a digital audio recording environment
it is important to make full use of the available dynamic range. One way to
do that is to make sure that the maximum peak level of a recording reaches
— but not exceeds — 0 dB. It can be very difficult to achieve this manually, as
peaks exceeding 0 dB cause digital distortion. Therefore it is common to set
the recording level in a way that the peak signals stop short a few dB below
0 dB. After recording, the program calculates the difference between the
maximum peak level and 0 dB and the complete file is increased in level by
the resulting amount. This procedure is called “Normalizing”.

If the maximum peak level in the file was e.g. -4 dB, then the complete file
will be increased in level by +4 dB.

As this is a purely mathematical procedure, no unwanted side-effects (like
background noise) occur. Background noise that was already present in the
recording before normalizing remains in the recording and is of course also
amplified.
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In spite of the possibility to normalize later, it is therefore a good idea to
make sure that the signal has a sufficient level when recording.

1. To normalize a file in WaveLab Lite, select the complete waveform by
pressing [Ctri]+[A] on your computer keyboard or selecting “Select All” in
the Edit menu.

2. Select “Normalize...” in the Level menu.
This dialog will appear:

Normalize 5Sound Level

I aximum level

[0.000 28 =~ SFF Apply I

[T As selected
]IL" Close |

¥ Stereo Link

" Mix to Mono & Heb |
Get peak level... ™ |

3. Make sure that “Maximum level is set to 0 dB (which is the default setting),
then click “Apply”.
Wavelab Lite will start calculations and a few moments later display the normalized
file in the Wave window. You can now save the file.

[0 Normalizing to 0 dB does not always make musical sense. A ballad, for in-
stance, might not need the same punch as a Rock Track. When you process
classical music, it is especially important to respect the dynamic changes
that the composer intended.
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Converting the Sample rate

Sometimes you may wish to process a file with CLEAN that was originally
recorded with a sample rate of 48 kHz instead of 44.1 kHz. In this case it is
necessary to convert the sample rate to 44.1 kHz.

1. Load the file in WaveLab Lite and select it (key command [Ctri]+[A]).

2. Now select “Convert sample rate...” from the Process menu.

3. In the dialog that appears, click on 44.1 kHz and start the conversion by
clicking on “OK”.

[0 Remember to save the file after processing!

Find out more about the many useful functions in WaveLab Lite by reading
its documentation — available in the Adobe Acrobat Reader
format (PDF) on the CLEAN program CD!
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